Getting Started with SAP HANA 2.0, express edition (Virtual Machine Method)
Content

1 Getting Started with SAP HANA 2.0, express edition (Virtual Machine Method) ........................................... 4
2 Installing SAP HANA 2.0, express edition (Virtual Machine Method) ............................................................... 5
   2.1 Pre-Installation Tasks ................................................................. 5
   2.2 Register .................................................................................. 7
   2.3 Download Using the Download Manager (GUI Mode) ............... 10
   2.4 (Optional) Download Using the Download Manager (Console Mode) .................................................. 14
   2.5 Import the OVA ................................................................. 18
3 Start Using SAP HANA 2.0, express edition (Virtual Machine Method) ......................................................... 21
   3.1 Set Keyboard and Time Zone .................................................. 21
   3.2 Start SAP HANA, express edition Server .................................. 25
   3.3 Edit the Hosts File ................................................................. 28
   3.4 Test SAP HANA, express edition ........................................... 29
4 Installing Optional Packages ..................................................... 34
   4.1 Install the Optional Text Analysis Files Package for SAP HANA, express edition .................................. 34
   4.2 Install the Optional SAP HANA Streaming Analytics Package for SAP HANA, express edition ................... 36
      (Optional) Create a Streaming Analytics User ................................. 37
      Edit the /etc/hosts File .......................................................... 38
      Install the Streaming Studio Plugin ......................................... 40
      Configure the Streaming Studio Plugin .................................... 41
      Configure the SAP HANA Streaming Analytics Service Broker ........ 44
      Configure Streaming Analytics Runtime Tool Permissions ......... 45
   4.3 Install the Optional SAP Enterprise Architecture Designer Package for SAP HANA, express edition ................. 45
   4.4 Install the Optional SAP HANA Interactive Education Package for SAP HANA, express edition ......................... 50
   4.5 Install the Optional SAP HANA External Machine Learning Library Package for SAP HANA, express edition .............. 51
   4.6 Install the Optional SAP HANA Automated Predictive Library Package for SAP HANA, express edition ................. 52
   4.7 Install the Optional Clients Package for SAP HANA, express edition .................................................. 53
      Installing SAP HANA HDB Client (Windows) ............................ 53
      Installing SAP HANA HDB Client (Mac) .................................... 56
      Installing SAP HANA HDB Client (Linux) .................................. 58
      Installing SAP HANA HDB Client (PowerPC) ......................... 60
      Installing XS CLI Client ..................................................... 62
   4.8 Install the Optional SAP HANA Smart Data Integration Package for SAP HANA, express edition .............. 65
### Content

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Configuring Data Collection</td>
<td>75</td>
</tr>
<tr>
<td>5.1</td>
<td>Disable and Enable Data Collection via Command Line</td>
<td>76</td>
</tr>
<tr>
<td>5.2</td>
<td>Check your Proxy Settings</td>
<td>76</td>
</tr>
<tr>
<td>6</td>
<td>Advanced Configuration</td>
<td>79</td>
</tr>
<tr>
<td>6.1</td>
<td>Adjust the Global Allocation Limit</td>
<td>79</td>
</tr>
<tr>
<td></td>
<td>Virtual Machine: Checking Resource Usage</td>
<td>80</td>
</tr>
<tr>
<td>7</td>
<td>Best Practices</td>
<td>81</td>
</tr>
<tr>
<td>7.1</td>
<td>Backups</td>
<td>81</td>
</tr>
<tr>
<td>7.2</td>
<td>Deactivate the SYSTEM user</td>
<td>81</td>
</tr>
<tr>
<td>8</td>
<td>Updating SAP HANA, express edition</td>
<td>82</td>
</tr>
<tr>
<td>9</td>
<td>Uninstalling SAP HANA, express edition</td>
<td>84</td>
</tr>
<tr>
<td>9.1</td>
<td>Uninstalling the SAP EA Designer Component</td>
<td>84</td>
</tr>
<tr>
<td>10</td>
<td>Troubleshooting</td>
<td>85</td>
</tr>
<tr>
<td>10.1</td>
<td>SAP HANA XS Applications Run Error</td>
<td>85</td>
</tr>
<tr>
<td>10.2</td>
<td>Download Manager Shows Error &quot;Failed to concatenate downloaded files&quot;</td>
<td>85</td>
</tr>
<tr>
<td>10.3</td>
<td>Unable to Obtain an IPv4 Address in VMWare</td>
<td>86</td>
</tr>
<tr>
<td>10.4</td>
<td>Error Indicates Package is not Compatible with Installed SAP HANA, Express Edition Version</td>
<td>86</td>
</tr>
<tr>
<td>10.5</td>
<td>Upgrade Script Hangs While Upgrading VM Installation</td>
<td>87</td>
</tr>
<tr>
<td>10.6</td>
<td>Error When Accessing the Database Explorer from Cockpit</td>
<td>88</td>
</tr>
<tr>
<td>10.7</td>
<td>Error When Stopping the System from Cockpit</td>
<td>89</td>
</tr>
</tbody>
</table>
1 Getting Started with SAP HANA 2.0, express edition (Virtual Machine Method)

You will learn how to download the VM image of SAP HANA 2.0, express edition, install the image on your laptop, and get started.
2 Installing SAP HANA 2.0, express edition (Virtual Machine Method)

Perform pre-installation tasks, register the product, download the server and optional packages, and import the OVA file into your hypervisor.

2.1 Pre-Installation Tasks

The virtual machine (VM) installation method is the simplest SAP HANA 2.0, express edition on-premise installation method for compatible Windows, OS X, and Linux laptops. Perform these pre-installation tasks first, before you register.

Context

These installation tutorials are also available as a video.

Procedure

1. Understand the Virtual Machine installation method.

The SAP HANA 2.0, express edition VM image is platform-independent. You can install it to a Windows, OS X, or Linux machine, provided your laptop meets the storage and memory prerequisites. Choose the VM installation method if you want the simplest on-premise installation experience.

(If you need a custom setup, use the Binary Installer Method, which is for Linux machines – running specific installations – that meet certain storage and memory prerequisites. See Getting Started with SAP HANA 2.0, express edition (Binary Installer Method)).

The Virtual Machine method installs:

- A VM running SUSE Linux Enterprise Server (SLES) for SAP Applications 12 SP2.
- An SAP HANA 2.0, express edition instance on the VM, preconfigured and ready to start.

You can download two different installation packages depending on your requirements:

- A server-only virtual machine package: the server plus XSC, and the Application Function Library (AFL).
- A server + applications virtual machine package: the server and XS Advanced, Web IDE, and SAP HANA Cockpit. This package requires more RAM.

Note

SAP HANA 2.0, express edition is officially supported on SLES. SAP Community members have been successful in running SAP HANA, express edition on other Linux operating systems that are not formally supported.
supported by SAP, such as Ubuntu, openSUSE, Fedora, and RedHat. SAP is not committing to resolving any issues that may arise from running SAP HANA, express edition on these platforms.

2. Note changes from version 1.0.

If you’re familiar with the older 1.0 SPS 12 version, note this important change:
  ○ The instance number has changed from 00 to 90.

See the release notes for information on what’s new and changed in this release of SAP HANA 2.0, express edition.

3. Ensure your laptop meets the software requirements.

Check if your laptop has the recommended software to successfully install and run the SAP HANA 2.0, express edition VM package.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Runtime Environment 8</td>
<td>The Download Manager requires Java SE Runtime Environment 8 (JRE 8) or higher. You can download the SAP JVM (64-bit) from <a href="https://tools.hana.ondemand.com/#cloud">https://tools.hana.ondemand.com/#cloud</a>.</td>
</tr>
</tbody>
</table>

i Note

If you plan to use the SAP HANA, express edition Download Manager for Windows or Linux, you need the 64-bit JRE. If you are planning to use the platform-independent Download Manager, you can use either the 32- or 64-bit JRE.

4. Ensure your laptop meets the hardware requirements.

Check if your laptop has the recommended software to successfully install and run the SAP HANA 2.0, express edition VM package.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM - Server-only virtual machine</td>
<td>8 GB RAM minimum. (If you add additional components, or run heavy processing loads, you will need to increase your RAM.)</td>
</tr>
<tr>
<td>RAM - Server plus applications virtual machine</td>
<td>16 GB RAM minimum. 24 GB RAM recommended.</td>
</tr>
<tr>
<td>HDD</td>
<td>120 GB HDD recommended.</td>
</tr>
<tr>
<td>Cores</td>
<td>2 cores (4 recommended).</td>
</tr>
</tbody>
</table>
**Hardware Virtualization**

(Intel processors only) For Intel processors, virtualization is a BIOS setting known as either Intel Virtualization Technology or Intel VT. If virtualization is turned off on your virtualization-capable machine, consult documentation from your machine vendor on how to enable virtualization technology (or Intel VT) in the BIOS.

Go to [Determine If Your Processor Supports Intel Virtualization Technology](#) to determine if your processor is capable of supporting virtualization.

**Tip**

Concerned about memory? The memory consumption of each optional component is listed in the [SAP HANA 2.0, express edition Sizing Guide (Virtual Machine Method)](#).

5. Install a hypervisor.

Hypervisors are software products used for creating and running virtual machines. Install a supported hypervisor on your laptop if you don’t have one already. SAP HANA 2.0, express edition has been tested on these hypervisors:

- **VMware Workstation Player 12.x** - [https://my.vmware.com/web/vmware/downloads](https://my.vmware.com/web/vmware/downloads)
- **VMware Workstation Pro 12.x** - [https://my.vmware.com/web/vmware/downloads](https://my.vmware.com/web/vmware/downloads)
- **VMware Fusion 8.x** - [https://my.vmware.com/web/vmware/downloads](https://my.vmware.com/web/vmware/downloads)
- **Oracle VirtualBox** ([https://www.virtualbox.org](https://www.virtualbox.org))

Example installation procedure for **VMware Workstation Player 12.x**:

- Download **VMware Workstation Player**. Ensure you’re downloading the correct version for your machine.
- Run the installer.
- Register **VMware Workstation Player** when prompted, and follow the setup instructions.

### 2.2 Register

Register your copy of SAP HANA, express edition to access the download manager.

### Procedure

1. Open the registration page.

The registration page opens.

2. Complete the registration form.

Enter all required information and click the Register button.

Note

If you have an SAP login, click the Login icon at the top of the page to populate the registration form automatically.

The Registration Success page displays. (You will also receive an email indicating successful registration.)

3. Choose a download manager.

Under **1A. ON-PREMISE INSTALLATION**, click the download manager that matches your system: Linux or Windows.

If you have a Mac, or another type of machine, click **Platform-independent** for a platform-independent download manager.
You must click the download manager links on the Registration Success page. If you attempt to copy a download manager URL to your browser, the download will fail with an error.

4. Save the download manager file.

Save the download manager file to your laptop and open it. If your system displays a security warning when you open the file, ignore the warning.

If you are inside a corporate firewall, you will be prompted for your proxy settings. Contact your IT administrator for your proxy host and proxy port information.
2.3 Download Using the Download Manager (GUI Mode)

Use the Download Manager (GUI mode) to download a server-only virtual machine package, or a server + applications virtual machine package.

Context

You can also download optional installation packages, like the SAP Enterprise Architecture Designer Package, at this point in your installation, before you’ve started the server. However, SAP does not recommend downloading optional installation packages until after your server is installed and running. SAP recommends you download optional installation packages after you’ve installed, and recommends you use the built-in console mode Download Manager.

Procedure

1. Select the Linux/x86-64 platform.
   In Download Manager, from the Platform pull-down, select SAP HANA, express edition on Linux/x86-64.
   (Virtual machine method installation is not available for Linux/Power (little endian).)

2. Select the VM image.
   From the Image pull-down, select Virtual Machine.
3. Specify a save directory.
   Click **Browse** and select a directory where your downloads will be saved.
4. Select an OVA and user guide.
   Select one or more of the following packages:
   - **Getting Started with SAP HANA, express edition (Virtual Machine Method)** - Selected by default. Downloads this document.
   - **Server only virtual machine** - Downloads *hxe.ova*; the server plus XSC, and the Application Function Library (AFL).
   - **Server + applications virtual machine** - Downloads *hxexsa.ova*; the server plus XS Advanced, Web IDE, and SAP HANA Cockpit.

   **Note**
   SAP plans to remove SAP HANA extended application services, classic model (XSC) and the corresponding SAP HANA Repository with the next major product version of SAP HANA.
   
   These components will be removed:
   - SAP HANA extended application services, classic model
   - SAP HANA Repository (XS classic)
   - SAP HANA Studio (Development, Modeling, and Administration perspectives)
   - SAP HANA Web-based Development Workbench (XS classic)

   SAP strongly advises you to plan the transition of existing content and applications from XSC to SAP HANA extended application services, advanced model (XS Advanced).

5. (Optional) Download optional installation packages.
   You can download optional installation packages now (before your server is running), but note that you will need to transfer the installation files to your VM once downloaded. Transfer instructions vary depending on your hypervisor, and are not included in this documentation.

   **Note**
   SAP recommends you wait until your server is installed and running, and then download optional installation packages using the server’s built-in Download Manager (console mode). This latter method is faster and more efficient. For instructions on downloading optional installation packages *after* your server is installed and running, see Installing Optional Packages [page 34].

   **Tip**
   Concerned about memory? The memory consumption of each additional package is listed in the SAP HANA 2.0, express edition Sizing Guide (Virtual Machine Method).

   If downloading optional installation packages now, select one or more of the following:
   - **Text analysis files for additional languages** - Downloads *additional_lang.tgz*. For languages other than English and German, this package is required for the HANA Text Analysis function. (The text analysis files for English and German are already included in the **Server only virtual machine** and **Server + applications virtual machine** packages.) For the text analysis files installation procedure, see Install the Optional Text Analysis Files Package for SAP HANA, express edition [page 34].
- **SAP Enterprise Architecture Designer** - This optional package is only valid on server + application virtual machine. File name is eadesigner.tgz. SAP EA Designer lets you capture, analyze, and present your organization’s landscapes, strategies, requirements, processes, data, and other artifacts in a shared environment.

- **SAP HANA streaming analytics** - Downloads hsa.tgz, which contains SAP HANA streaming analytics. See Install the Optional SAP HANA Streaming Analytics Package for SAP HANA, express edition [page 36] for installation steps.

- **SAP HANA streaming analytics studio plug-in** - Downloads hsa_plugin.zip, which contains an Eclipse plugin for creating and deploying streaming analytics projects. For installation steps, see the Install the Streaming Studio Plugin [page 40] topic.

- **SAP HANA Interactive Education** - This optional package is only valid on server + application virtual machine. Download file name is shine.tgz. SHINE makes it easy to learn how to build applications on SAP HANA Extended Application Services Advanced Model (XSA). See Install the Optional SAP HANA Interactive Education Package for SAP HANA, express edition [page 50].

- **SAP HANA External Machine Learning Library** - The SAP HANA External Machine Learning Library is an application function library (AFL) supporting the integration of Google TensorFlow, as an external machine learning framework, with SAP HANA, express edition. Download file name is eml.tgz.

- **SAP HANA Automated Predictive Library** - SAP HANA Automated Predictive Library (APL) is an application function library which exposes the data mining capabilities of the Automated Analytics engine in SAP HANA through a set of functions. Download file name is apl.tgz.

- **Clients (Linux x86/64)** - Client download package for Linux machines (x86/64 architectures). Use the client packages to access developed SAP HANA, express edition applications from a client PC. See Install the Optional Clients Package for SAP HANA, express edition [page 53]. The package includes:
  - hdb_client_linux.tgz - Reduced HANA client for Linux 64 bit. Contains the HANA client package, drivers, and required licenses.
  - xs.onpremise.runtime.client_linuxx86_64.zip - Command-line tools for Linux that enable access to (and control of) the SAP HANA XS advanced run-time environment.

- **Clients (Linux PPC/Little Endian)** - Client download package for Linux machines (little endian on Power architectures). Use the client packages to access developed SAP HANA, express edition applications from a client PC. See Install the Optional Clients Package for SAP HANA, express edition [page 53]. The package includes:
  - hdb_client_linux_ppc64le.tgz - Reduced HANA client for Linux on Power. Contains the HANA client package, drivers, and required licenses.
  - xs.onpremise.runtime.client_linuxppc64le.zip - Command-line tools for Linux on Power that enable access to (and control of) the SAP HANA XS advanced run-time environment.

- **Clients (Windows)** - Client download package for Windows machines. Use the client packages to access developed SAP HANA, express edition applications from a client PC. See Install the Optional Clients Package for SAP HANA, express edition [page 53]. The package includes:
  - hdb_client_windows_x86_32.zip - Reduced HANA client for Windows 32-bit. Contains the HANA client package, drivers, and required licenses.
  - hdb_client_windows_x86_64.zip - Reduced HANA client for Windows 64-bit. Contains the HANA client package, drivers, and required licenses.
  - xs.onpremise.runtime.client_ntamd64.zip - Command-line tools for Windows that enable access to (and control of) the SAP HANA XS advanced run-time environment.
- **Clients (Mac)** - Client download package for Mac. Use the client packages to access developed SAP HANA, express edition applications from a client PC. See [Install the Optional Clients Package for SAP HANA, express edition](page 53). The package includes:
  - hdb_client_mac.tgz - Reduced HANA client for Mac. Contains the HANA client package, drivers, and required licenses.
  - xs.onpremise.runtime.client_darwinintel64.zip - Command-line tools for Mac that enable access to (and control of) the SAP HANA XS advanced run-time environment. Reduced HANA client for Mac. Contains the HANA client package, drivers, and required licenses.

- **SAP HANA smart data integration** - SAP HANA smart data integration provides functionality to access source data, and to provision, replicate, and transform that data in SAP HANA on premise, or in the cloud.
  Download file name is sdi.tgz. See [Install the Optional SAP HANA Smart Data Integration Package for SAP HANA, express edition](page 65).

- **SAP HANA smart data integration - Data Provisioning Agent (Linux X86/64)** - The Data Provisioning Agent provides secure connectivity between the SAP HANA database and your adapter-based sources. Download file name is dpagent_linux_x86_64.tgz. See [Install the Optional SAP HANA Smart Data Integration Package for SAP HANA, express edition](page 65).

6. Download your selections.

   Click the **Download** button.

   Your download is complete when a pop-up message appears confirming successful download. Make sure you wait for this message before accessing the downloaded files.

**Related Information**

(Optional) Download Using the Download Manager (Console Mode) [page 14]
2.4 (Optional) Download Using the Download Manager (Console Mode)

Run the Download Manager in console mode on your laptop if you’re used to a command line interface. Also, the SAP HANA, express edition server contains a built-in HXEDownloadManager_linux.bin (Console Mode) which lets you download additional packages from within the VM itself.

Prerequisites

If the Download Manager (GUI Mode) is running, close it.

Context

i Note
The Download Manager for Windows (HXEDownloadManager_win.exe) runs in asynchronous mode, and console mode is not available. If you are a Windows user, download the platform-independent Download Manager (HXEDownloadManager.jar) to use console mode.

Procedure

1. Open a command prompt at the location where you saved the Download Manager file (HXEDownloadManager.jar, or HXEDownloadManager_linux.bin).

   i Note
   If you’ve already installed SAP HANA express edition using the Virtual Machine method, call the Download Manager at the hxehost:hxeadm> prompt.

2. Display the command help using the -h argument.

   Linux Download Manager example:
   
   ```bash
   HXEDownloadManager_linux.bin -h
   ```

   Platform-independent Download Manager example:
   
   ```bash
   java -jar HXEDownloadManager.jar -h
   ```
i Note
You must include an argument with each command. If you call the Download Manager without an argument, it opens in GUI mode.

3. Familiarize yourself with the command syntax, and the command arguments.

Command syntax is:

```
HXEDownloadManager [{ [-h|-X] | [-d <save_directory>] [--ph <proxy_host>] [--pp <proxy_port>] <platform> <image> <file>... ]}
```

Command arguments are:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-h</td>
<td>Print this help</td>
</tr>
<tr>
<td>-X</td>
<td>Print extended help</td>
</tr>
<tr>
<td>-d &lt;save_directory&gt;</td>
<td>Directory where to save the download file. Default is %USERPROFILE%\Downloads on Windows; and ~/Downloads on Linux.</td>
</tr>
<tr>
<td>--ph &lt;proxy_host&gt;</td>
<td>Proxy host name or IP address.</td>
</tr>
<tr>
<td>--pp &lt;proxy_port&gt;</td>
<td>Proxy port.</td>
</tr>
<tr>
<td>&lt;platform&gt;</td>
<td>HANA platform. Valid values are linuxx86_64, linuxppc64le.</td>
</tr>
<tr>
<td>&lt;image&gt;</td>
<td>Type of image to download. Valid values for linuxx86_64 platform are: vm, installer. Valid values for linuxppc64le platform are: installer.</td>
</tr>
<tr>
<td>&lt;file&gt;</td>
<td>File(s) to download.</td>
</tr>
</tbody>
</table>

Valid <file> values for linuxx64_64 platform and VM image:

<table>
<thead>
<tr>
<th>&lt;file&gt; value (linuxx64_64)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hxe.ova</td>
<td>Downloads hxe.ova; the server plus XSC and Application Function Library (AFL).</td>
</tr>
<tr>
<td>hxexsa.ova</td>
<td>Downloads hxexsa.ova; the server plus XS Advanced, Web IDE, and SAP HANA Cockpit.</td>
</tr>
<tr>
<td><strong>&lt;file&gt; value (linuxx86_64)</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>additional_lang.tgz</td>
<td>Downloads additional_lang.tgz. For languages other than English and German, this package is required for the HANA Text Analysis function. (The text analysis files for English and German are already included in the hxe.ova and hxexsa.ova packages.) For installation steps, see Start Using SAP HANA 2.0, express edition (Virtual Machine Method) [page 21].</td>
</tr>
<tr>
<td>eadesigner.tgz</td>
<td>Valid only with hxexsa.ova. SAP EA Designer lets you capture, analyze, and present your organization's landscapes, strategies, requirements, processes, data, and other artifacts in a shared environment. For installation steps, see Install the Optional SAP Enterprise Architecture Designer Package for SAP HANA, express edition [page 45].</td>
</tr>
<tr>
<td>hsa.tgz</td>
<td>Downloads SAP HANA streaming analytics. For installation steps, see Install the Optional SAP HANA Streaming Analytics Package for SAP HANA, express edition [page 36].</td>
</tr>
<tr>
<td>hsa_plugin.zip</td>
<td>Downloads the Eclipse plugin for creating and deploying streaming analytics projects. For installation steps, see Install the Streaming Studio Plugin [page 40].</td>
</tr>
<tr>
<td>shine.tgz</td>
<td>Valid only with hxexsa.ova. SAP HANA Interactive Education (SHINE) makes it easy to learn how to build applications on SAP HANA Extended Application Services Advanced Model (XSA). For installation steps, see Install the Optional SAP HANA Interactive Education Package for SAP HANA, express edition [page 50].</td>
</tr>
<tr>
<td>eml.tgz</td>
<td>Downloads HANA Extended Machine Learning AFL.</td>
</tr>
<tr>
<td>apl.tgz</td>
<td>Downloads SAP HANA Automated Predictive Library.</td>
</tr>
<tr>
<td>clients_linux_x86_64.tgz</td>
<td>Client download package for Linux machines (x86/64 architectures). Use the client packages to access developed SAP HANA, express edition applications from a client PC. For installation steps, see Install the Optional Clients Package for SAP HANA, express edition [page 53].</td>
</tr>
<tr>
<td>clients_linux_ppc64le.tgz</td>
<td>Client download package for Linux machines (little endian on Power architectures). Use the client packages to access developed SAP HANA, express edition applications from a client PC. For installation steps, see Install the Optional Clients Package for SAP HANA, express edition [page 53].</td>
</tr>
</tbody>
</table>
### Description

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>clients_windows.zip</td>
<td>Client download package for Windows machines. Use the client packages to access developed SAP HANA, express edition applications from a client PC. For installation steps, see Install the Optional Clients Package for SAP HANA, express edition [page 53].</td>
</tr>
<tr>
<td>clients_mac.tgz</td>
<td>Client download package for Mac. Use the client packages to access developed SAP HANA, express edition applications from a client PC. For installation steps, see Install the Optional Clients Package for SAP HANA, express edition [page 53].</td>
</tr>
<tr>
<td>sdi.tgz</td>
<td>SAP HANA smart data integration download package. SAP HANA smart data integration provides functionality to access source data, and to provision, replicate, and transform that data in SAP HANA on premise, or in the cloud. For installation instructions, see Install the Optional SAP HANA Smart Data Integration Package for SAP HANA, express edition [page 65].</td>
</tr>
<tr>
<td>dpagent_linux_x86_64.tgz</td>
<td>SAP HANA smart data integration - Data Provisioning Agent (Linux X86/64) download package. The Data Provisioning Agent provides secure connectivity between the SAP HANA database and your adapter-based sources. For installation instructions, see Install the Optional SAP HANA Smart Data Integration Package for SAP HANA, express edition [page 65].</td>
</tr>
</tbody>
</table>

4. Download one or more files.

This example uses the Linux Download Manager `HXEDownloadManager_linux.bin`. It specifies a proxy host, proxy port, and downloads *Getting Started with SAP HANA, express edition (Virtual Machine Method)* and the SHINE package (`shine.tgz`).

```
HXEDownloadManager_linux.bin --ph proxy.yourcompany.corp --pp 8080 linuxx86_64 vm Getting_Started_HANAexpress_VM.pdf shine.tgz
```

This example uses the platform-independent Download Manager `HXEDownloadManager.jar`.

It downloads *Getting Started with SAP HANA, express edition (Virtual Machine Method)* and `hxexsa.ova`.

```
java -jar HXEDownloadManager.jar linuxx86_64 vm Getting_Started_HANAexpress_VM.pdf hxexsa.ova
```
2.5 Import the OVA

Import the downloaded Open Virtual Appliance (OVA) file into your hypervisor to begin using SAP HANA 2.0, express edition.

Context

This example uses VMware Player as the hypervisor. You can use any supported hypervisor.

Procedure

1. Open an existing virtual machine.
   Start VMware Player and select Open a Virtual Machine.
2. Open the OVA file.

   Browse to the OVA file you downloaded and click **Open**.

   The Import Virtual Machine dialog box displays.

3. Import the VM.

   Accept the defaults and click **Import**. The VM imports.

   ![Import Virtual Machine dialog box]

   The import process takes approximately 5 minutes for **hxe.ova**.

   The import process takes approximately 5-10 minutes for **hxexsa.ova**.

4. Power on your VM.

   Click **Play Virtual Machine**.
Play virtual machine
3 Start Using SAP HANA 2.0, express edition (Virtual Machine Method)

Once you've downloaded the SAP HANA 2.0, express edition Virtual Machine package, start the server, change the default passwords to secure your system, and connect using client tools.

3.1 Set Keyboard and Time Zone

The VM defaults to an English (US) QWERTY keyboard, and the UTC time zone. When prompted, change the keyboard layout and time zone to match your location, or accept the defaults.

Context

If you don’t change the keyboard layout to match the physical keyboard of your host machine (referred to as your laptop in this documentation), you may encounter problems later when logging in.

Procedure

1. Start your VM.
   - Open your hypervisor application.
   - Power on (or click Play on) your SAP HANA 2.0, express edition VM.
2. Change the keyboard layout if your laptop doesn't use an English (US) keyboard.

The system prompts you to either change the VM keyboard, or accept the default English (US) QWERTY keyboard. Enter `Y` to change the keyboard or `N` to use the default.
If you opt to change the keyboard, the System Keyboard Configuration page displays.
Use the arrow keys to scroll to the desired keyboard layout. Press $\text{Tab}$ to the OK button, or press $\text{F10}$ to save your changes. A message displays while the system processes the keyboard layout change.

3. Change time zone.

Change the time zone if your laptop is not in the default UTC (GMT) time zone.

Enter $\text{Y}$ to change the time zone, or $\text{N}$ to accept the default.

If you opt to change the timezone, the Clock and Time Zone page displays.
In the Region pane, use the arrow keys to scroll down to the correct region. Tab to the Time Zone pane and select the correct time zone. Tab to the OK button, or press F10 to save your changes.

3.2 Start SAP HANA, express edition Server

Once you've downloaded the SAP HANA 2.0, express edition Virtual Machine package and set the keyboard and time zone, log in and change the default passwords to secure your system.

Context

Tip
This tutorial is available as a video.
Procedure

1. Note the VM IP address.

   The IP address of the VM is displayed on the login screen. Make a note of the IP address, since you’ll need it in future steps.

   ![Image of login screen]

   i Note

   If the IP address and other information in this image does not show, wait few seconds and press Enter.

   If the IP address still doesn’t show, check and correct the network setting on your hypervisor then restart your VM.

2. Log in.

   At the hxehost login prompt, enter hxeadm.

   For Password, enter the temporary password HXEHana1.

   ![Image of login screen]

   When prompted for (current) UNIX password, enter the temporary password again: HXEHana1

3. Enter new password.

   When prompted for New password, enter a strong password with at least 8 characters. If your password is not strong enough, the system logs you off and you must log in again.

   ➤ Tip

   SAP HANA, express edition requires a very strong password that complies with these rules:
   
   ○ At least 8 characters
   ○ At least 1 uppercase letter
   ○ At least 1 lowercase letter
   ○ At least 1 number
Strong password example: E15342GcbaFd. Do not use this password example, since it is public and not secure. This example is for illustrative purposes only and must not be used on your system. Define your own strong password.

4. Retype new password.

When prompted to Retype new password, enter your strong password again.

5. Enter new HANA database master password.

When prompted for New HANA database master password, enter a strong password. Make a note of this password, since you’ll need it later. You can enter the same password you used in step 3, or a new password. If you are entering a new password, see the password rules in step 3.

Entering the HANA database master password changes the SYSTEM user password. If you are installing the server + applications virtual machine, it also changes the XSA_ADMIN and XSA_DEV user passwords.

6. Confirm HANA database master password.

When prompted to Confirm "HANA database master password", enter the strong password again.

7. Enter proxy settings.

When prompted Do you need to use the proxy server to access the internet? enter Y or N.

○ Contact your IT administrator for your company’s proxy settings. If you are inside a corporate firewall, you might use a proxy for connecting to http and https servers.

○ If y, enter your proxy host name, proxy port number, and (if desired) a comma-separated list of hosts that do not need a proxy. Proxy host name needs a fully qualified domain name.
- Make sure the Non Proxy Host list includes `localhost`, `hxehost`, and `hxehost.localdomain`.

8. (Server + Applications VM Only) Wait for XSA configuration.
   
   Decide whether you want to wait for XSA configuration to complete before starting the server. When prompted to **Wait for XSA configuration to finish**, enter `Y` if you want to wait.

   Enter `N` if you want XSA to configure in the background after server configuration completes.

9. Complete the installation.
   
   When prompted to **Proceed with configuration?** enter `Y`.

   Wait for the success message **Congratulations! SAP HANA, express edition 2.0 is configured.**

   SAP HANA 2.0, express edition is now running.

### 3.3 Edit the Hosts File

The `hxehost` IP address is private to the VM. In order for applications on your laptop (like your web browser) to access `hxehost`, add the `hxehost` IP address to your laptop’s hostname map.

**Procedure**

1. Update `etc/hosts` on Windows.
   
   If you installed the VM installation package to a Windows machine, follow this step to update the `etc/hosts` file.
   
   a. On your Windows laptop, navigate to `C:\Windows\System32\drivers\etc`.
   
   b. In **Administrator** mode, open `hosts` in Notepad. See your operating system Help for information on opening applications in Administrator mode.
   
   c. In a new uncommented row, add the IP address and `hxehost`. Save your changes.
      
      Spacing is important. Make sure your hosts file in Notepad looks like this image.
2. Update `etc/hosts` on Mac and Linux.

If you installed the VM installation package to a Mac or Linux machine, follow this step to update the `etc/hosts` file.

a. On your Mac or Linux machine, start the Terminal application.

b. Enter the following command:

```
sudo sh -c 'echo <hxehost IP address>    hxehost >> /etc/hosts'
```

### 3.4 Test SAP HANA, express edition

Test your XSC, XSA, SAP Web IDE, and Cockpit installations.

**Context**

**Note**

Make sure you edited your `/etc/hosts` file before starting this procedure.
Procedure

1. Test XSC.

Check that the XSEngine is running. From your host OS (not the VM guest) open a browser and enter:

\[ \text{http://hxehost IP address}:8090 } \]

You recorded the IP address earlier. A success page displays. This indicates that XSC is running:

Note

SAP plans to remove SAP HANA extended application services, classic model (XSC) and the corresponding SAP HANA Repository with the next major product version of SAP HANA.

These components will be removed:
- SAP HANA extended application services, classic model
- SAP HANA Repository (XS classic)
- SAP HANA Studio (Development, Modeling, and Administration perspectives)
- SAP HANA Web-based Development Workbench (XS classic)

SAP strongly advises you to plan the transition of existing content and applications from XSC to SAP HANA extended application services, advanced model (XS Advanced).

2. Test XSA. (Server + Applications VM only)
   a. Go back to your VM. Log in to XSA services:

\[ \text{xs-admin-login } \]

b. When prompted for the XSA_ADMIN password, enter the master password.

You specified this password when you were prompted for HANA database master password in Start SAP HANA 2.0, express edition.

3. Test SAP Web IDE. (Server + Applications VM only)
   a. View the list of XSA applications. Enter:

\[ \text{xs apps } \]
b. Check that the application `webide` shows **STARTED** in the list of XSA applications, and has 1/1 instances. (If the list shows 0/1 in the instance column, the application is not started.)

i Note

Normally it only takes a few minutes for XSA services to start. However, depending on your machine, it can take over 30 minutes for XSA services to begin. If the service doesn’t show **STARTED** and doesn’t show 1/1 instances, keep waiting until the service is enabled.

Make a note of the URL for `webide`.

```
done-ui5  STARTED  1/1  120 MB <unlimited> https://hxehost:51024
di-runway  STARTED  1/1  256 MB <unlimited> https://hxehost:51025
di-cert-admin-ui  STARTED  1/1  16.0 MB <unlimited> https://hxehost:51026
di-space-provisioning-ui  STARTED  1/1  16.0 MB <unlimited> https://hxehost:51027
webide  STARTED  1/1  512 MB <unlimited> https://hxehost:53075
webui4b  STOPPED  1/1  256 MB <unlimited> https://hxehost:53076
webui4b-rest  STOPPED  1/1  1.00 GB <unlimited> https://hxehost:53078
```

Tip

The command `xs apps | grep webide` returns the `webide` row only.

c. Test your Web IDE connection. Enter the URL for Web IDE in a browser on your laptop.

Example: https://hxehost:53075

d. Log on to Web IDE using the `XSA_DEV` user.

You specified this password when you were prompted for **HANA database master password** in Start SAP HANA 2.0, express edition.

If you are prompted to change your password, follow the instructions.

4. Test Cockpit. (Server + Applications VM only)

a. Go back to your VM. Check that the application `cockpit-admin-web-app` shows **STARTED** in the list of XSA applications and has 1/1 instances.

i Note

Normally it only takes a few minutes for XSA services to start. However, depending on your machine, it can take over 30 minutes for XSA services to begin. If the service doesn’t show **STARTED** and doesn’t show 1/1 instances, keep waiting until the service is enabled.

Make a note of the URL for `cockpit-admin-web-app`. 
Tip
The command `xs apps | grep cockpit-admin-web-app` returns the `cockpit-admin-web-app` row only.

b. Check that the application `xsa-admin` shows `STARTED` in the list of XSA applications and has 1/1 instances.

Note
Normally it only takes a few minutes for XSA services to start. However, depending on your machine, it can take over 30 minutes for XSA services to begin. If the service doesn’t show `STARTED` and doesn’t show 1/1 instances, keep waiting until the service is enabled.

Make a note of the URL for `xsa-admin`.

c. In a browser on your laptop, enter the `cockpit-admin-web-app` URL you noted earlier.

The Cockpit log in page displays.

5. (Optional) Test with HANA Eclipse Plugin.

Download and install the HANA Eclipse Plugin to your host OS (not the VM guest) and connect to SAP HANA 2.0, express edition.

a. Download Eclipse IDE for Java EE Developers from Eclipse, for Neon or Mars releases, to your local file system.

b. Follow the eclipse installer prompts.

c. Launch when prompted, or go to the eclipse folder (example: `C:\Users\<path>\eclipse\jee-neon`) and run the eclipse executable file.

d. Follow the tutorial How to download and install the HANA Eclipse plugin.
Related Information

Start SAP HANA, express edition Server [page 25]
4 Installing Optional Packages

Use the Download Manager to install optional packages, such as SAP HANA Interactive Education (SHINE).

4.1 Install the Optional Text Analysis Files Package for SAP HANA, express edition

If you are using SAP HANA 2.0, express edition in a language other than English or German, you can download the Text analysis files for additional languages package in the Download Manager.

Context

The Text analysis files for additional languages package contains the text analysis files for the HANA Text Analysis feature (for languages other than English or German).

Note

Use the server’s built-in Download Manager (Console Mode) for Linux to download additional_lang.tgz. When logged-in as hxeadm, you can access the download manager (HXEDownloadManager_linux.bin) in directory /usr/sap/HXE/home/bin.

Procedure

1. Run the memory management script.

   The hxe_gc memory management script frees up available VM memory.
   ○ In your VM, log in as hxeadm and enter:
     cd /usr/sap/HXE/home/bin
   ○ Execute:
     hxe_gc.sh
   ○ When prompted for System database user (SYSTEM) password, enter the New HANA database master password you specified during SAP HANA, express edition installation.

   The cleanup process runs. The command prompt returns when the cleanup process is finished.

2. Download additional_lang.tgz.
In your VM, download `additional_lang.tgz` using the built-in Download Manager. From the same directory where you ran `hxe_gc (/usr/sap/HXE/home/bin)` enter:

```
HXEDownloadManager_linux.bin linuxx86_64 vm additional_lang.tgz
```

3. **Update folder permissions.**

In your VM, update the folder permissions on the `lang` folder.

Navigate to `/hana/shared/<SID>/global/hdb/custom/config/lexicon/`

Enter this command:

```
chmod 755 lang
```

4. **Extract `additional_lang.tgz`.**

This step extracts `<download_path>/additional_lang.tgz` to `/hana/shared/HXE/global/hdb/custom/config/lexicon/`. Enter this command:

```
tar -xvzf /usr/sap/HXE/home/Downloads/additional_lang.tgz -C /hana/shared/HXE/global/hdb/custom/config/lexicon
```

**Tip**

If your tables do not use a full text index, or if your tables use a full text index but contain very little data, you can save about 120 MB of memory if you turn off the standalone text analysis preprocessor, and activate the embedded text analysis preprocessor.

Stop the standalone preprocessor:

```
alter system alter configuration ('daemon.ini','SYSTEM') set ('preprocessor','instances') = '0' with reconfigure;
```

Start the embedded preprocessor:

```
alter system alter configuration ('preprocessor.ini','SYSTEM') set ('general','embedded') = 'true' with reconfigure;
```
4.2 Install the Optional SAP HANA Streaming Analytics Package for SAP HANA, express edition

Install the SAP HANA client package and SAP HANA streaming analytics on an SAP HANA, express edition system.

Prerequisites

For more information about sizing requirements for streaming analytics projects, see the Sizing and Configuration Guidelines document.

Context

**Note**

Use the server’s built-in Download Manager (Console Mode) for Linux to download hsa.tgz. When logged-in as hxeadm, you can access the download manager (HXEDownloadManager_linux.bin) in directory /usr/sap/HXE/home/bin.

Procedure

1. Run the hxe_gc memory management script to free up available VM memory.
   a. In your VM, log in as hxeadm and enter:
   
   ```
   cd /usr/sap/HXE/home/bin
   ```
   
   b. Execute:
   
   ```
   hxe_gc.sh
   ```
   
   c. When prompted for System database user (SYSTEM) password, enter the New HANA database master password you specified during SAP HANA, express edition installation.
   
   The cleanup process runs. The command prompt returns when the cleanup process is finished.

2. In your VM, download hsa.tgz using the built-in Download Manager. From the same directory where you ran hxe_gc (/usr/sap/HXE/home/bin) enter:

   ```
   HXEDownloadManager_linux.bin linuxx86_64 vm hsa.tgz
   ```

3. Extract the contents of hsa.tgz:

   ```
   tar -xvzf <download_path>/hsa.tgz
   ```
Run the `tar` command from the command shell as shown, rather than using a GUI-based extraction tool.

You may have to give these files run permissions. Example:

```bash
chmod -R 777 <path_where_you_extracted_hsa.tgz>
```

4. Edit the `/etc/hosts` file on your virtual machine.
   a. Enter the `/etc/hosts` file editor as `sudo` using the `vi` editor.
      ```bash
      sudo vi /etc/hosts
      ```
   b. Press `i` to edit the file and modify the `hxehost.localdomain hxehost` line to have your virtual machine's IP address.
      The `/etc/hosts` line should read like the following:
      ```bash
      <VM_IP_address> hxehost.localdomain hxehost
      ```

5. Navigate to the `/HANA_EXPRESS_20` directory where you extracted the files and run `install_hsa.sh` as the root user:
      ```bash
      cd <extracted_path>/HANA_EXPRESS_20
      sudo ./install_hsa.sh
      ```

6. Follow the prompts to configure your installation.

The system database user (SYSTEM) password you enter during installation is used for the `SYS_STREAMING` and `SYS_STREAMING_ADMIN` users.

### 4.2.1 (Optional) Create a Streaming Analytics User

Create a new user with permissions to perform all streaming analytics tasks.

**Context**

By default, the SYSTEM user has permission to perform all tasks in streaming analytics. If you have disabled the SYSTEM user, or plan to do so, follow these steps to create a new user with the same permissions.
**Procedure**

1. In a terminal, log in as the hxeadm user:
   ````
sudo su -l hxeadm
   ````

2. Create a new user, SA_USER:
   ````
   /usr/sap/HXE/HDB90/exe/hdbsql -i 90 -d HXE -u SYSTEM -p "<SYSTEM-password>"
   "CREATE USER SA_USER PASSWORD <password> NO FORCE_FIRST_PASSWORD_CHANGE;"
   ````

3. If you are using the server + applications image, grant the CATALOG READ permission to the user:
   ````
   /usr/sap/HXE/HDB90/exe/hdbsql -i 90 -d HXE -u SYSTEM -p "<SYSTEM-password>"
   "GRANT CATALOG READ TO SA_USER"
   ````

4. Grant streaming analytics permissions to the user:
   ````
   $STREAMING_HOME/bin/streamingclusteradmin --uri=esps://hxehost:39016 --
   username=SYS_STREAMING --password=<password> --admin_policy --command="grant
   perm all to user SA_USER"
   ````

**4.2.2 Edit the /etc/hosts File**

If you’re running SAP HANA, express edition in a virtual machine or cloud server instance, then depending on the network configuration, you may need to edit the `/etc/hosts` file on your local machine so Eclipse can connect to the streaming analytics server.

**4.2.2.1 Edit /etc/hosts on Windows**

If you are running Eclipse on a Windows machine, follow these steps to update the `/etc/hosts` file.

**Procedure**

1. On your Windows laptop, navigate to `C:\Windows\System32\drivers\etc`.
2. In Administrator mode, open `hosts` in Notepad. See your operating system Help for information on opening applications in Administrator mode.
3. In a new uncommented row, add the IP address and hxehost. Save your changes.
   - Spacing is important. Make sure your hosts file in Notepad looks like this image.
4.2.2.2 Edit /etc/hosts on Mac and Linux

If you are running Eclipse on a Mac or Linux machine, follow these steps to update the /etc/hosts file.

Procedure

1. On your Mac or Linux machine, start the Terminal application.
2. Enter the following command:

   ```bash
   sudo sh -c 'echo <IP address>    <hostname> >> /etc/hosts'
   ```
4.2.3 Install the Streaming Studio Plugin

Install the streaming analytics plugin to develop and test streaming projects in Eclipse.

Prerequisites

You have installed Eclipse and the HANA Eclipse plugin. See the Test SAP HANA, express edition [page 29] tutorial for steps.

Procedure

1. Use the Download Manager to download the streaming studio plugin, hsa_plugin.zip

   Note
   
   Ensure you’re using the latest version of the Download Manager.

2. Extract the contents of the hsa_plugin.zip file:

   unzip <download_path>/hsa_plugin.zip

3. Open Eclipse and select Help Install New Software.

4. Click Add.

5. In the Add Repository dialog, click Local, select the <extracted_path>/<platform>/SAP_HANA_STREAMING/repository folder, and click OK.
6. In the install dialog, check SAP HANA streaming analytics, then click Next.
7. Review the items to be installed, then click Next.
8. Review the license, accept the terms and conditions to continue, then click Finish.
9. For any security warning prompts, click OK.
10. At the prompt to restart Eclipse, select Yes.
11. If you are installing the plugin into Eclipse for Linux, log off of the machine and log back in.

### 4.2.4 Configure the Streaming Studio Plugin

Add a connection to the streaming analytics server and create a HANA service.

**Prerequisites**

- You have installed the streaming analytics plugin for Eclipse.
- If necessary for your network configuration, you have edited the /etc/hosts file on the machine where you are using Eclipse. See Edit the /etc/hosts File for more information.
Procedure

1. In Eclipse, select Window > Perspective > Open Perspective > Other, then select the SAP HANA Streaming Development perspective and click OK.

2. Select Window > Perspective > Open Perspective > SAP HANA Streaming Run-Test.

3. In the SAP HANA Streaming Run-Test perspective, in the Server view, select New Server URL:

4. Enter the following connection details:
   - Host Name: hxehost or the IP address of the virtual machine
   - Port: 39016
     Enable SSL, then click OK.

5. Right-click on the new server and select Change User Name and Password.

6. Enter the credentials for SYSTEM and click OK.

   i Note
   To automatically connect to the streaming server when starting Eclipse, check Use Secure Storage for Streaming Credentials.

7. Right-click on the server and select Connect Server.

8. Open Window > Preferences and select SAP HANA streaming analytics from the list.

9. Set Default Server URL to the new server and click OK.

10. Switch to the SAP HANA Streaming Development perspective and select the Data Services tab:

11. Right-click on the new server and select Load Workspaces.

12. Right-click on the Server-wide folder and select Add HANA Service.

13. Select newservice1 and, in the Properties view:
a. Enter the credentials for SYSTEM.

b. Uncheck **Use Default HANA Server**.

c. Select **Multi Tenant**.

d. Set **Database Name** to HXE.

e. Set **HANA Hostname** to `hxehost` or the IP address for your SAP HANA, express edition installation.

f. Set **HANA Instance Number** to 90.

14. Right-click on `newservice1` and select **Rename Service**. Name the service `hanadb`.

15. To confirm that the HANA service is configured properly, right-click on it and select **Discover**.
4.2.5 Configure the SAP HANA Streaming Analytics Service Broker

If you want to use the WebIDE to develop streaming projects, configure the SAP HANA streaming analytics service broker to enable the streaming analytics plugin for WebIDE.

Procedure

1. As the `<sid>`adm user, enter the following command to add `diserver` to the tenant database:
   
   ```
   hdbsql -d SystemDB -u SYSTEM -p <password> "ALTER DATABASE <DB> ADD 'diserver'"
   ```

2. Log in to the XS Advanced Administration and Monitoring Tools as the XSA_ADMIN user.

   **Note**
   To find the URL, log in to XSA services and find `xsa-admin` on the applications list:
   
   ```
   xs login -u xsa_admin -p "<password>"
   xs apps | grep xsa-admin
   ```

3. Select the SAP HANA Logical Database Setup tile.
4. Select Enable on your tenant database.
5. Enter the credentials for the SYSTEM user and select OK.
6. Return to the main menu and select the SAP HANA Service Broker Configuration tile.
7. Select the HANAExpress / development organization and space and click Map.
8. Check the box next to your tenant database and click Map.
9. Return to the main menu and select the Service Broker Configuration tile in the SAP HANA Streaming Analytics section.
10. Open the HANA System Database Provisioning tab and click Edit.
11. Fill in the login information for the SYSTEM user, then click Save.
12. Open the Streaming Service Provisioning tab.
13. Choose your tenant database and click Register.
   
   If the streaming service status is Not Provisioned, the service has not been provisioned to the tenant database, or has not been initiated.
14. Enter the SYS_STREAMING password when prompted, then click Save.

   **Note**
   By default, the password for the SYS_STREAMING user is the same as the password for the database user (SYSTEM) you used when installing streaming analytics.

You can now use the streaming analytics plugin in the SAP HANA Web IDE.
4.2.6 Configure Streaming Analytics Runtime Tool Permissions

Update the DEVX_DEVELOPER role to give XSA_DEV access to the streaming analytics runtime tool.

Procedure

1. Log in to the XS Advanced Administration and Monitoring Tools as the XSA_ADMIN user.

   Note

   To find the URL, log in to XSA services and find xsa-admin on the applications list:

   ```
   xs login -u xsa_admin -p "<password>"
   xs apps | grep xsa-admin
   ```

2. Open the Application Role Builder tile.
3. Select Configure Role Collections.
4. In the Role Collections list, select DEVX_DEVELOPER.
5. On the Roles tab for DEVX_DEVELOPER, select Add Application Role.
6. Select the following options, then click OK:
   - Application Name: com-sap-xsa-sds-rtt
   - Template Name: xsa_sds_rtt_developer_template
   - Application Role: xsa_sds_rtt_developer_template
7. Select Save.

4.3 Install the Optional SAP Enterprise Architecture Designer Package for SAP HANA, express edition

If you downloaded the Server + Applications Virtual Machine package (hxexsa.ova), you have the option of installing the SAP Enterprise Architecture Designer (SAP EA Designer) tool.

Prerequisites

You edited your laptop’s hosts file. See Edit the Hosts File [page 28].
Context

SAP EA Designer lets you capture, analyze, and present your organization’s landscapes, strategies, requirements, processes, data, and other artifacts in a shared environment. Using industry-standard notations and techniques, organizations can leverage rich metadata and use models and diagrams to drive understanding and promote shared outcomes in creating innovative systems, information sets, and processes to support goals and capabilities.

SAP EA Designer is a separate download in the Download Manager.

In this procedure you’ll download the SAP EA Designer package (eadesigner.tgz) using the built-in Download Manager (Console Mode), extract the package, and run the installation script.

i Note

Use the server’s built-in Download Manager (Console Mode) for Linux to download eadesigner.tgz. When logged-in as hxeadm, you can access the download manager (HXEDownloadManager_linux.bin) in directory /usr/sap/HXE/home/bin.

Procedure

1. Run the memory management script.
   The hxe_gc memory management script frees up available VM memory.
   - In your VM, log in as hxeadm and enter:
     
     cd /usr/sap/HXE/home/bin
   - Execute:
     
     hxe_gc.sh
   - When prompted for System database user (SYSTEM) password, enter the New HANA database master password you specified during SAP HANA, express edition installation.

   The cleanup process runs. The command prompt returns when the cleanup process is finished.

2. Download eadesigner.tgz using the built-in Download Manager.
   In your VM, from the same directory where you ran hxe_gc (/usr/sap/HXE/home/bin), enter:

   HXEDownloadManager_linux.bin linuxx86_64 vm eadesigner.tgz
3. Navigate to the Downloads directory.

   In your VM, enter:
   ```
   cd /usr/sap/HXE/home/Downloads
   ```

4. View the contents of the Downloads directory to confirm eadesigner.tgz exists.

   In your VM, enter:
   ```
   ls
   ```

5. Extract the file.

   In your VM, enter:
   ```
   tar -xvzf eadesigner.tgz
   ```

6. Navigate to the HANA_EXPRESS_20 directory.

   In your VM, enter:
   ```
   cd HANA_EXPRESS_20
   ```

7. Run the installation script.
In your VM, enter:

```
sh ./install_eadesigner.sh
```

Installation begins.

8. Follow the installation prompts.

   ○ When prompted for HANA instance number [90] press `Enter` to accept the default.
   ○ When prompted for System database user (SYSTEM) password, enter the hxeadm login password.
   ○ When prompted for XSA administrator (XSA_ADMIN) password, enter the HANA database master password you specified when you installed SAP HANA 2.0, express edition.

9. Complete the installation.

   When prompted to proceed with installation, enter `y`. Wait for installation to finish.

A success message displays when installation completes.

```
---------- deployment service CMD ---------------------
Deployment finished successfully.
Processing of results starts...
Results processed.
Register of software component starts...
Software component XSNC_HANA_EA_D (sap.com) 'SAP Enterprise Architecture Designer 1.8 for SAP HANA' successfully registered.
Process install finished successfully.
Performance /usr/sap/HXE/home/Downloads/HANA_EXPRESS_20-DataUnits-XSA_CONTENT_10-XSASCTNMVA002_0.ZIP F: UploadFiles 12.4 s (12417 ms), Installation 10 n 44 s (64571 ms).
Installation of archive file '/usr/sap/HXE/home/Downloads/HANA_EXPRESS_20-DataUnits-XSA_CONTENT_10-XSASCTNMVA002_0.ZIP' finished successfully.
To see installation logs execute 'xs display-installation-logs 3101 -scv'.
```

10. Confirm the status of SAP EA Designer.

   In your VM, enter:

   ```
   xs apps
   ```

   The output will include all the applications of your organization and space. You should see:

   ○ eadesigner - The SAP EA Designer application
   ○ eadesigner-service - The SAP EA Designer Node application
   ○ eadesigner-backend - The SAP EA Designer Java application
   ○ eadesigner-db - The SAP EA Designer database creation application. This application will have a state of STOPPED when the installation is complete.

```
<table>
<thead>
<tr>
<th>Application</th>
<th>State</th>
<th>Memory</th>
<th>Disk</th>
</tr>
</thead>
<tbody>
<tr>
<td>cockpit-admin-web-app</td>
<td>STARTED</td>
<td>1/1</td>
<td>120 MB</td>
</tr>
<tr>
<td>eadesigner-db</td>
<td>STOPPED</td>
<td>0/1</td>
<td>256 MB</td>
</tr>
<tr>
<td>eadesigner-backend</td>
<td>STARTED</td>
<td>1/1</td>
<td>1.50 GB</td>
</tr>
<tr>
<td>eadesigner</td>
<td>STARTED</td>
<td>1/1</td>
<td>512 MB</td>
</tr>
<tr>
<td>eadesigner-service</td>
<td>STARTED</td>
<td>1/1</td>
<td>512 MB</td>
</tr>
<tr>
<td>hxehost:hxeadm</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

11. Log in.

   ○ Note the URL for eadesigner.
○ Launch a web browser on your laptop and enter the URL in your web browser address bar. The SAP EA Designer login page displays.

○ Click **Login with your XSA User** on this logon page.

○ Enter XSA_ADMIN user and password. You are logged in as administrator of SAP EA Designer.
4.4 Install the Optional SAP HANA Interactive Education Package for SAP HANA, express edition

SAP HANA Interactive Education (SHINE) makes it easy to learn how to build applications on SAP HANA Extended Application Services Advanced Model (XSA).

Context

SHINE is a separate download in the Download Manager. To use SHINE, you need the Server + Applications Virtual Machine (hxexsa.ova) package. Use the Download Manager to download the SAP HANA Interactive Education package, shine.tgz.

Note

Use the server’s built-in Download Manager (Console Mode) for Linux to download shine.tgz. When logged-in as hxeadm, you can access the download manager (HXEDownloadManager_linux.bin) in directory /usr/sap/HXE/home/bin.

Procedure

1. Run the memory management script.
   Run the hxe_gc memory management script to free up available VM memory.
   a. In your VM, log in as hxeadm and enter:

   ```
   cd /usr/sap/HXE/home/bin
   ```
   
   b. Execute:

   ```
   hxe_gc.sh
   ```
   
   c. When prompted for System database user (SYSTEM) password, enter the New HANA database master password you specified during SAP HANA, express edition installation.

   The cleanup process runs. The command prompt returns when the cleanup process is finished.

2. Download shine.tgz.
   In your VM, download shine.tgz using the built-in Download Manager. From the same directory where you ran hxe_gc (/usr/sap/HXE/home/bin) enter:

   ```
   HXEDownloadManager_linux.bin linuxx86_64 vm shine.tgz
   ```

3. Extract shine.tgz.
   In your VM, extract shine.tgz:

   ```
   tar -xvzf shine.tgz
   ```
4. Run the installation script.

As the hxeadm user, run:

```
<extracted_path>/HANA_EXPRESS_20/install_shine.sh
```

4.5 Install the Optional SAP HANA External Machine Learning Library Package for SAP HANA, express edition

The SAP HANA External Machine Learning Library is an application function library (AFL) supporting the integration of Google TensorFlow, as an external machine learning framework, with SAP HANA, express edition.

Context

i Note

Use the server’s built-in Download Manager (Console Mode) for Linux to download eml.tgz. When logged-in as hxeadm, you can access the download manager (HXEDownloadManager_linux.bin) in directory /usr/sap/HXE/home/bin.

Procedure

1. Run the memory management script.

   Run the hxe_gc memory management script to free up available VM memory.
   
   a. In your VM, log in as hxeadm and enter:

   ```
   cd /usr/sap/HXE/home/bin
   ```

   b. Execute:

   ```
   hxe_gc.sh
   ```

   c. When prompted for System database user (SYSTEM) password, enter the New HANA database master password you specified during SAP HANA, express edition installation.

   The cleanup process runs. The command prompt returns when the cleanup process is finished.

2. Download eml.tgz.

   In your VM, download eml.tgz using the built-in Download Manager. From the same directory where you ran hxe_gc (/usr/sap/HXE/home/bin) enter:

   ```
   HXEDownloadManager_linux.bin linuxx86_64 vm eml.tgz
   ```
3. Extract `eml.tgz`.
   In your VM, extract `eml.tgz`.
   ```
   tar -xvzf eml.tgz
   ```

4. Run the installation script.
   As the `<hxeadm>` user, run:
   ```
   <extracted_path>/HANA_EXPRESS_20/install_eml.sh
   ```

4.6 Install the Optional SAP HANA Automated Predictive Library Package for SAP HANA, express edition

SAP HANA Automated Predictive Library (APL) is an application function library which exposes the data mining capabilities of the Automated Analytics engine in SAP HANA, express edition through a set of functions.

**Context**

SAP HANA Automated Predictive Library is a separate download in the Download Manager. Use the Download Manager to download the SAP HANA Automated Predictive Library package, `apl.tgz`.

**Procedure**

1. Run the memory management script.
   Run the `hxe_gc` memory management script to free up available VM memory.
   a. In your VM, log in as `hxeadm` and enter:
   ```
   cd /usr/sap/HXE/home/bin
   ```
   b. Execute:
   ```
   hxe_gc.sh
   ```
   c. When prompted for System database user (SYSTEM) password, enter the New HANA database master password you specified during SAP HANA, express edition installation.
      The cleanup process runs. The command prompt returns when the cleanup process is finished.

2. Download `apl.tgz`.
   In your VM, download `apl.tgz` using the built-in Download Manager. From the same directory where you ran `hxe_gc` (/usr/sap/HXE/home/bin) enter:
   ```
   HXEDownloadManager_linux.bin linuxx86_64 vm apl.tgz
   ```
3. Extract apl.tgz.

In your VM, extract apl.tgz.

```
tar -xvzf apl.tgz
```

4. Run the installation script.

As the hxeadm user, run:

```
<extracted_path>/HANA_EXPRESS_20/install_apl.sh
```

### 4.7 Install the Optional Clients Package for SAP HANA, express edition

Install the clients if you intend to develop XS applications on a machine that will not have a local SAP HANA 2.0, express edition installation.

The clients let you access SAP HANA 2.0, express edition from your client machine.

You can install the clients on the SAP HANA 2.0, express edition server during server installation, but this how-to assumes you are installing the clients on a different machine than the machine where SAP HANA 2.0, express edition is installed.

This how-to refers to the laptop with SAP HANA 2.0, express edition as the *server machine*, and your local machine as the *client machine*.

#### 4.7.1 Installing SAP HANA HDB Client (Windows)

Install the client package if you intend to develop XS applications on a machine that will not have a local SAP HANA 2.0, express edition installation.

**Context**

The *server machine* in these instructions refers to the laptop on which SAP HANA 2.0, express edition is installed, while *client machine* refers to your local machine. You do not need to install the two on same machine or VM.

The clients let you access SAP HANA 2.0, express edition, from your client machine. This is the Reduced SAP Client package.

The clients included with the SAP HANA HDB client software package are:

- SQLDBC
- ODBC
To install the SAP HANA HDB client on a Windows machine, use either a graphical user interface or a command line.

**Procedure**

1. Download the client package.
   
   Install the Download Manager to your client machine and download the client package.
   
   1. Save the Download Manager installation files to your client machine and open it. For instructions on downloading and running the Download Manager, see either the *Installing SAP HANA 2.0, express edition (Binary Installer Method)* tutorials, or go straight to the SAP HANA, express edition registration page.
   
   2. In Download Manager, in the Image menu, select either Virtual Machine or Binary Installer.
   
   3. Click Browse and select a directory where your client package will be saved.
   
   4. Select the Clients package that matches the machine you will be installing the clients on. Clear the Select boxes of all other packages.
   
   5. Click Download. The hdb_client_<OS>.tgz file (clients_windows.zip for Windows) downloads to your save directory.
   
   6. Extract the compressed clients file:
      
      ○ For Windows and Mac machines, use a compression utility.
      
      ○ For Linux, navigate to the directory in which you wish to extract the client files and use the `tar` command:

      ```bash
      cd <preferred_filepath>
sudo tar <download_filepath>/clients_<OS>.zip
      ```

      This extracts the following files and their contents:

      ```
      clients_linux_x86_64.tgz
      ○ hdb_client_linux_x86_64.tgz
      ○ xs.onpremise.runtime.client_linuxx86_64.zip

      clients_linux_ppc64.le.tgz
      ○ hdb_client_linux_ppc64le.tgz
      ○ xs.onpremise.runtime.client_linuxx86_64.zip

      clients_windows.zip
      ○ hdb_client_windows_x86_32.tgz
      ○ hdb_client_windows_x86_64.tgz
      ○ xs.onpremise.runtime.client_ntamd64.zip

      clients_mac.tgz
      ○ hdb_client_mac.tgz
      ○ xs.onpremise.runtime.client_darwinintel64.zip
      ```
2. Install the SAP HANA HDB client.

SAP HANA HDB client installation supports both GUI and console methods.

1. Use a compression utility to extract the downloaded files `hdb_client_windows_x86_32.zip` or `hdb_client_windows_x86_64.zip` for 32-bit and 64-bit installations respectively.

   The following file path is created:

   ```
   hdb_client_windows/HDB_CLIENT_WINDOWS_X86_32
   ```

   or

   ```
   hdb_client_windows/HDB_CLIENT_WINDOWS_X86_64
   ```

2. Navigate to the `HDB_CLIENT_WINDOWS_X86_32` or `HDB_CLIENT_WINDOWS_X86_64` folder.

3. In the file explorer, double-click:
   - `hdbsetup.exe` - GUI installation
   - `hdbinst.exe` - Command line installation
   Or from a command prompt:

   Call the program `hdbsetup` (GUI installation) or `hdbinst` (command line installation) by entering one of the following commands:
   - `GUI: hdbsetup [-a client]`
   - `Command Line: hdbinst [-a client] [<option list>]`

   Follow the onscreen prompts displayed by the installation tool.

4. Add the installation path to the PATH environment variable. For information on setting environment variables, see the documentation for your operating system.

3. Log the installation.

   The system automatically logs the SAP HANA HDB client installation. The log files are stored at `%TEMP%
   \hdb_client_<time_stamp>` for Windows and `/var/temp/hdb_client_<time_stamp>` for Linux.


   Connect to a SAP HANA 2.0, express edition system using either JDBC or Python.

   See these How-Tos:
   - Connect to SAP HANA, express edition using JDBC
   - Connect to SAP HANA, express edition using Python

5. Uninstall the SAP HANA HDB client.

   Each installation has its own uninstallation tool. Use the `hdbuninst` command to uninstall the client software from your command prompt.

   ```bash
   sudo <unzipped_filepath>/HDB_CLIENT_<version>/hdbuninst
   ```

   Follow the instructions on the screen to uninstall the SAP HANA HDB client.
4.7.2 Installing SAP HANA HDB Client (Mac)

Install the client package if you intend to develop XS applications on a machine that will not have a local SAP HANA 2.0, express edition installation.

Context

The server machine in these instructions refers to the laptop on which SAP HANA 2.0, express edition is installed, while client machine refers to your local machine. You do not need to install the two on same machine or VM.

The clients let you access SAP HANA 2.0, express edition, from your client machine. This is the Reduced SAP Client package.

The clients included with the SAP HANA HDB client software package are:

- SQLDBC
- ODBC
- JDBC
- Python (PyDBAPI)
- Node.js
- Ruby

To install the SAP HANA HDB client on a Windows machine, use either a graphical user interface or a command line.

Procedure

1. Download the client package.

   Install the Download Manager to your client machine and download the client package.

   1. Save the Download Manager installation files to your client machine and open it. For instructions on downloading and running the Download Manager, see either the Installing SAP HANA 2.0, express edition (Binary Installer Method) or Installing SAP HANA 2.0, express edition (Virtual Machine Method) tutorials, or go straight to the SAP HANA, express edition registration page.
   2. In Download Manager, in the Image menu, select either Virtual Machine or Binary Installer.
   3. Click Browse and select a directory where your client package will be saved.
   4. Select the Clients package that matches the machine you will be installing the clients on. Clear the Select boxes of all other packages.
   5. Click Download. The hdb_client_<OS>.tgz file (clients_windows.zip for Windows) downloads to your save directory.
   6. Extract the compressed clients file:
      - For Windows and Mac machines, use a compression utility.
For Linux, navigate to the directory in which you wish to extract the client files and use the `tar` command:

```
cd <preferred_filepath>
sudo tar <download_filepath>/clients_<OS>.zip
```

This extracts the following files and their contents:

- `clients_linux_x86_64.tgz`
- `hdb_client_linux_x86_64.tgz`
- `xs.onpremise.runtime.client_linuxx86_64.zip`
- `clients_linux_ppc64le.tgz`
- `hdb_client_linux_ppc64le.tgz`
- `xs.onpremise.runtime.client_linuxx86_64.zip`
- `clients_windows.zip`
- `hdb_client_windows_x86_32.tgz`
- `hdb_client_windows_x86_64.tgz`
- `xs.onpremise.runtime.client_ntamd64.zip`
- `clients_mac.tgz`
- `hdb_client_mac.tgz`
- `xs.onpremise.runtime.client_darwinintel64.zip`

2. **Install the SAP HANA HDB client.**

   To install the SAP HANA client on a Mac machine, do the following:
   
   1. Go to the directory where you wish to unpack the `hdb_client_mac.tgz` files:
      
      ```
      cd <your_destination>
      ```
   
   2. Unpack the file:
      
      ```
      sudo tar -xvzf <unzipped_filepath>/hdb_client_mac.tgz
      ```

      The directory `HDB_CLIENT_MACOS` is created.

   3. Navigate to the `HDB_CLIENT_MACOS` directory and run `hdbinst` to start the installer:
      
      ```
      cd HDB_CLIENT_MACOS
      sudo ./hdbinst
      ```

      Follow the instructions on the screen to install the SAP HANA HDB client.

3. **Log the installation.**

   The system automatically logs the SAP HANA HDB client installation. The log files are stored at `%TEMP%\hdb_client_<time_stamp>` for Windows and `/var/temp/hdb_client_<time_stamp>` for Linux.

4. **Connect to SAP HANA, express edition.**

   Connect to a SAP HANA 2.0, express edition system using either JDBC or Python.

   See these **How-Tos:**

   - Connect to SAP HANA, express edition using JDBC
   - Connect to SAP HANA, express edition using Python

5. **Uninstall the SAP HANA HDB client.**
Each installation has its own uninstallation tool. Use the `hdbuninst` command to uninstall the client software from your command prompt.

```
sudo <unzipped_filepath>/HDB_CLIENT_<version>/hdbuninst
```

Follow the instructions on the screen to uninstall the SAP HANA HDB client.

### 4.7.3 Installing SAP HANA HDB Client (Linux)

Install the client package if you intend to develop XS applications on a machine that will not have a local SAP HANA 2.0, express edition installation.

**Context**

The *server machine* in these instructions refers to the laptop on which SAP HANA 2.0, express edition is installed, while *client machine* refers to your local machine. You do not need to install the two on same machine or VM.

The clients let you access SAP HANA 2.0, express edition, from your client machine. This is the Reduced SAP Client package.

The clients included with the SAP HANA HDB client software package are:

- SQLDBC
- ODBC
- JDBC
- Python (*PyDBAPI*)
- Node.js
- Ruby

To install the SAP HANA HDB client on a Windows machine, use either a graphical user interface or a command line.

**Procedure**

1. Download the client package.

   Install the Download Manager to your client machine and download the client package.

   1. Save the Download Manager installation files to your client machine and open it. For instructions on downloading and running the Download Manager, see either the [Installing SAP HANA 2.0, express edition (Binary Installer Method)](Installing SAP HANA 2.0, express edition (Binary Installer Method)) or [Installing SAP HANA 2.0, express edition (Virtual Machine Method)](Installing SAP HANA 2.0, express edition (Virtual Machine Method)) tutorials, or go straight to the SAP HANA, express edition registration page.
   2. In Download Manager, in the *Image* menu, select either *Virtual Machine* or *Binary Installer*.
   3. Click *Browse* and select a directory where your client package will be saved.
4. Select the Clients package that matches the machine you will be installing the clients on. Clear the Select boxes of all other packages.

5. Click Download. The hdb_client_<OS>.tgz file (clients_windows.zip for Windows) downloads to your save directory.

6. Extract the compressed clients file:
   - For Windows and Mac machines, use a compression utility.
   - For Linux, navigate to the directory in which you wish to extract the client files and use the tar command:
     ```bash
cd <preferred_filepath>
sudo tar <download_filepath>/clients_<OS>.zip
```
   This extracts the following files and their contents:
   - clients_linux_x86_64.tgz
     - hdb_client_linux_x86_64.tgz
     - xs.onpremise.runtime.client_linuxx86_64.zip
   - clients_linux_ppc64.le.tgz
     - hdb_client_linux_ppc64le.tgz
     - xs.onpremise.runtime.client_linuxx86_64.zip
   - clients_windows.zip
     - hdb_client_windows_x86_32.tgz
     - hdb_client_windows_x86_64.tgz
     - xs.onpremise.runtime.client_ntamd64.zip
   - clients_mac.tgz
     - hdb_client_mac.tgz
     - xs.onpremise.runtime.client_darwinintel64.zip

2. Install the SAP HANA HDB client.
   
   To install the SAP HANA client on a Linux machine, do the following:
   1. Go to the directory where you wish to unpack the hdb_client_linux_x86_64.tgz files:
      ```bash
cd <your_destination>
```
   2. Unpack the file:
      ```bash
      sudo tar -xvzf <unzipped_filepath>/hdb_client_linux_x86_64.tgz
      ``
   The directory HDB_CLIENT_LINUX_X86_64 is created.
   3. Navigate to the HDB_CLIENT_LINUX_X86_64 directory and run hdbinst to start the installer:
      ```bash
cd HDB_CLIENT_LINUX_X86_64
      sudo ./hdbinst
      ``
   Follow the instructions on the screen to install the SAP HANA client.

3. Log the installation.
   
   The system automatically logs the SAP HANA HDB client installation. The log files are stored at %TEMP% \hdb_client_<time_stamp> for Windows and /var/temp/hdb_client_<time_stamp> for Linux.

Now that you’ve installed the SAP HANA HDB Client, connect to a SAP HANA 2.0, express edition system.

See these How-Tos:
- Connect to SAP HANA, express edition using JDBC
- Connect to SAP HANA, express edition using Python

5. Uninstall the SAP HANA HDB client.

Each installation has its own uninstallation tool. Use the hdbuninst command to uninstall the client software from your command prompt.

```sh
sudo <unzipped_filepath>/HDB_CLIENT_<version>/hdbuninst
```

Follow the onscreen instructions to uninstall the SAP HANA HDB client.

### 4.7.4 Installing SAP HANA HDB Client (PowerPC)

Install the client package if you intend to develop XS applications on a machine that will not have a local SAP HANA 2.0, express edition installation.

#### Context

The `server machine` in these instructions refers to the laptop on which SAP HANA 2.0, express edition is installed, while `client machine` refers to your local machine. You do not need to install the two on same machine or VM.

The clients let you access SAP HANA 2.0, express edition, from your client machine. This is the Reduced SAP Client package.

The clients included with the SAP HANA HDB client software package are:
- SQLDBC
- ODBC
- JDBC
- Python (PyDBAPI)
- Node.js
- Ruby

To install the SAP HANA HDB client on a Windows machine, use either a graphical user interface or a command line.

#### Procedure

1. Download the client package.

   Install the Download Manager to your client machine and download the client package.
1. Save the Download Manager installation files to your client machine and open it. For instructions on downloading and running the Download Manager, see either the Installing SAP HANA 2.0, express edition (Binary Installer Method) or Installing SAP HANA 2.0, express edition (Virtual Machine Method) tutorials, or go straight to the SAP HANA, express edition registration page.

2. In Download Manager, in the Image menu, select either Virtual Machine or Binary Installer.

3. Click Browse and select a directory where your client package will be saved.

4. Select the Clients package that matches the machine you will be installing the clients on. Clear the Select boxes of all other packages.

5. Click Download. The hdb_client_<OS>.tgz file (clients_windows.zip for Windows) downloads to your save directory.

6. Extract the compressed clients file:
   - For Windows and Mac machines, use a compression utility.
   - For Linux, navigate to the directory in which you wish to extract the client files and use the tar command:
     ```bash
     cd <preferred_filepath>
     sudo tar <download_filepath>/clients_<OS>.zip
     ```
     This extracts the following files and their contents:
     - clients_linux_x86_64.tgz
       - hdb_client_linux_x86_64.tgz
       - xs.onpremise.runtime.client_linuxx86_64.zip
     - clients_linux_ppc64le.tgz
       - hdb_client_linux_ppc64le.tgz
       - xs.onpremise.runtime.client_linuxx86_64.zip
     - clients_windows.zip
       - hdb_client_windows_x86_32.tgz
       - hdb_client_windows_x86_64.tgz
       - xs.onpremise.runtime.client_ntamd64.zip
     - clients_mac.tgz
       - hdb_client_mac.tgz
       - xs.onpremise.runtime.client_darwinintel64.zip

2. Install the SAP HANA HDB client.
   - To install the SAP HANA client on a Linux PowerPC machine, do the following:
     1. Go to the directory where you wish to unpack the hdb_client_linux_x86_64.tgz files:
        ```bash
        cd <your_destination>
        ```
     2. Unpack the file:
        ```bash
        sudo tar -xvzf <unzipped_filepath>/hdb_client_linux_ppc64le.tgz
        ```
        The directory HDB_CLIENT_LINUX_X86_64 is created.
     3. Navigate to the HDB_CLIENT_LINUX_X86_64 directory and run hdbinst to start the installer:
        ```bash
        cd HDB_CLIENT_LINUX_PPC64LE
        sudo ./hdbinst
        ```
Follow the instructions on the screen to install the SAP HANA HDB client.

3. Log the installation.

The system automatically logs the SAP HANA HDB client installation. The log files are stored at %TEMP% \hdb_client_<time_stamp> for Windows and /var/temp/hdb_client_<time_stamp> for Linux.


Connect to a SAP HANA 2.0, express edition system using either JDBC or Python.

See these How-Tos:
- Connect to SAP HANA, express edition using JDBC
- Connect to SAP HANA, express edition using Python

5. Uninstall the SAP HANA HDB client.

Each installation has its own uninstallation tool. Use the hdbuninst command to uninstall the client software from your command prompt.

```
sudo <unzipped_filepath>/HDB_CLIENT_<version>/hdbuninst
```

Follow the instructions on the screen to uninstall the SAP HANA HDB Client.

### 4.7.5 Installing XS CLI Client

Install the client package if you intend to develop XS applications on a machine that will not have a local SAP HANA 2.0, express edition installation. The clients let you access SAP HANA 2.0, express edition from your client machine.

#### Context

The `server machine` in these instructions refers to the machine on which SAP HANA 2.0, express edition is installed, while `client machine` refers to your local machine. You do not need to install the two on the same machine or VM.

#### Procedure

1. XS CLI client info.

   The XS advanced client-tools bundle (`xs.onpremise.runtime.client_<platform>-<version>.zip`) also includes the Javascript bundle (`xs_javascript-1.3.0-bundle.tar.gz`), which includes a selection of mandatory Node.js packages developed by SAP for use with the Node.js applications running XS Advanced runtime.

   You can use the XS command line client to perform a wide variety of developer- and administrator-related tasks. For example, in the role of a developer, you can use the XS CLI to connect to the XS Advanced...
runtime installed on the server machine, log on as a specific user, and deploy and manage your applications.

2. Download the client package.

Install the Download Manager to your client machine and download the client package.

1. Save the Download Manager installation files to your client machine and open it. For instructions on downloading and running the Download Manager, see either
2. In Download Manager, in the Image pull-down, select either Virtual Machine or Binary Installer.
3. Click Browse and select a directory where your client package will be saved.
4. Select the Clients package that matches the machine you will be installing the clients on. Clear the Select boxes of all other packages.
5. Click Download. The hdb_client_<OS>.tgz file, or clients_windows.zip for Windows, downloads to your save directory.
6. Extract the compressed clients file:
   ○ For Windows and Mac machines, use a compression utility.
   ○ For Linux, navigate to the directory in which you wish to extract the client files and use the tar command.

```
    cd <preferred_filepath>
sudo tar <download_filepath>/clients_<OS>.zip
```

These files are extracted:
clients_linux_x86_64.tgz
   ○ hdb_client_linux_x86_64.tgz
   ○ xs.onpremise.runtime.client_linuxx86_64.zip
clients_linux_ppc64.le.tgz
   ○ hdb_client_linux_ppc64le.tgz
   ○ xs.onpremise.runtime.client_linuxppc64le.zip
clients_windows.zip
   ○ hdb_client_windows_x86_32.tgz
   ○ hdb_client_windows_x86_64.tgz
   ○ xs.onpremise.runtime.client_ntamd64.zip
clients_mac.tgz
   ○ hdb_client_mac.tgz
   ○ xs.onpremise.runtime.client_darwinintel64.zip
3. Install the XS CLI client.

Use a compression utility to extract the file you downloaded for your platform:
   ○ (Windows) xs.onpremise.runtime.client_ntamd64.zip
   ○ (Mac) xs.onpremise.runtime.client_darwinintel64.zip
   ○ (Linux) xs.onpremise.runtime.client_linuxx86_64.zip
   ○ (PowerPC) xs.onpremise.runtime.client_linuxppc64le.zip

The system creates this folder:
```
    xs.onpremise.runtime.client_<version>
```
4. Verify XS Advanced runtime is installed.
Enter the following URL into your Web browser:

https://<hana_hostname>:3<instance>/v2/info

For example:

https://my.hana.server:39030/v2/info

The response displayed in the Web browser is a JSON string with details that indicate whether there was a successful connection to the XSA controller. The connection must exist before you can connect from within the API command.

5. Confirm XS Advanced is Available

On your client machine, open a command window and run the following.

```
xs help
xs -v
```

On Linux, run these as `<sid>adm`.

You see the **Client Version** in the output. If not, you cannot connect to XS Advanced runtime on SAP HANA to deploy your XS Advanced applications.

6. Connect to XS Advanced controller.

Specify the URL of the API end point on the SAP HANA server you want to connect to:

```
xs api https://<hostname>:3<instance_number>/30
```

**Note**

If this step fails, it may be due to a missing SSL certificate. Continue on to the next step to add the SSL certificate, otherwise skip the next step.

7. Add SSL certificate to connect to the server.

Open a command session on the server machine or open a PuTTY session to the server machine. From the command prompt, log in as **sudo** and go to the certificate **default.root.crt.pem**, which is typically located here:

```
<installation_path>/<SID>/xs/controller_data/controller/ssl-pub/router
```

For example, where `<installation_path>` is `/hana/shared` and `<SID>` is `HDB` the certificate location would be:

```
/hana/shared/HDB/xs/controller_data/controller/ssl-pub/router/default.root.crt.pem
```

Copy the certificate to a folder on the server where you can easily access it. Using an FTP client or the `scp` command, send a copy of the certificate from your server machine to a safe location on your client machine.

**FTP:**

```
/<path>/default.root.crt.pem
```
scp:

```
scp <server_machine_user>@<ip_address_server>:/default.root.crt.pem
<client_machine_user>@<ip_address_client>:/<your_desired_filepath>
```

Exit your FTP and PuTTY sessions and return to your client machine. Try the previous command again, but use the `-cacert` option and specify the local certificate you just copied:

```
xs api https://<hostname>:3<instance_number>30 -cacert "<copied_filepath>/default.root.crt.pem"
```

Log on to the SAP HANA instance specified in the API end point that you set in a previous step. SAP HANA provides the default `XSA_ADMIN` user with administrator permissions. Although you can use this user ID to test the connection, you should create a new user with more limited permissions to use for developer tasks.

To log on, run the following:

```
xs login -u XSA_ADMIN -p "<password>"
```

**Note**

A password is assigned to the `XSA_ADMIN` user during SAP HANA 2.0, express edition installation.

8. Test the XS Advanced connection.

To test your connection to XS Advanced by running the following command on the SAP HANA 2.0, express edition server:

```
xs apps
```

### 4.8 Install the Optional SAP HANA Smart Data Integration Package for SAP HANA, express edition

Install SAP HANA smart data integration on an SAP HANA, express edition system.

**Prerequisites**

You must have SAP HANA, express edition installed prior to following the steps below.

**Context**

You need to run a script and an installer executable to complete the necessary steps to install SAP HANA smart data integration. The script enables the Data Provisioning Server on SAP HANA, express edition, as well as
deploy the data provisioning delivery unit that enables monitoring and other capabilities. The installer executable that you run installs the Data Provisioning Agent that provides connectivity between SAP HANA, express edition and your remote data sources.

**Note**
The current version of SAP HANA, express edition supports only one Data Provisioning Agent per machine.

**Note**
Use the server’s built-in Download Manager (Console Mode) for Linux to download sdi.tgz. When logged-in as hxeadm, you can access the download manager (HXEDownloadManager_linux.bin) in directory /usr/sap/HXE/home/bin.

**Procedure**

1. Run the memory management script.
   
   Run the `hxe_gc` memory management script to free up available VM memory
   
   a. In your VM, log in as hxeadm and enter:
      
      ```bash
      cd /usr/sap/HXE/home/bin
      ```
   
   b. Execute:
      
      ```bash
      hxe_gc.sh
      ```
   
   c. When prompted for System database user (SYSTEM) password, enter the New HANA database master password you specified during SAP HANA, express edition installation.

      The cleanup process runs. The command prompt returns when the cleanup process is finished.

2. Download `sdi.tgz`:
   
   In your VM, download `sdi.tgz` using the built-in Download Manager. From the same directory where you ran `hxe_gc` (/usr/sap/HXE/home/bin) enter:
      
      ```bash
      HXEDownloadManager_linux.bin linuxx86_64 vm sdi.tgz
      ```

3. Extract `sdi.tgz`.
   
   In your VM, extract `sdi.tgz`.
      
      ```bash
      tar -xvzf sdi.tgz
      ```

4. Run the installation script.
   
   As the hxeadm user, run:
      
      ```bash
      HANA_EXPRESS_20/install_sdi.sh
      ```

   This enables the DP Server on HANA and deploys the monitoring delivery unit.

5. Install the Data Provisioning Agent.
To install the Data Provisioning Agent, run `<extract directory>/HANA_EXPRESS_20/DATA_UNITS/HANA_DP_AGENT_20_LIN_X86_64/hdbinst.exe`.

You are prompted to supply the following information (default values are given):
- Installation path `/usr/sap/dataprovagent`
- Enter User name for Agent service (user must exist)
- Enter Agent Listener Port [5050]
- Enter Agent Administration Port [5051]
- Enter Shared directory for Agent Group (optional)
- Enter Custom JRE directory (to use bundled JRE, leave it blank)

The SAP JVM is bundled with the Data Provisioning Agent and used as the default Java Runtime Environment. You can choose to update the version of the SAP JVM used by an installed agent, or replace it with a custom Java Runtime Environment.

6. Authorize the agent user.

**Note**
The default installation location (`/usr/sap/dataprovagent`) requires the agent user to have write access to the `/usr/` directory.

You must create or use an existing non-root agent user that is authorized to open a display and has full read and write access to the intended installation location.

Prior to installation, grant the agent user the appropriate permissions (use `sudo` to create the `/usr/sap/dataprovagent` directory and grant permissions to the user) or choose a different installation location.

7. Assign roles and privileges.

Add roles and privileges for users to perform various tasks. The following tables list common tasks and roles or privileges that an administrator needs to assign to complete those tasks.

**Data Provisioning Agent and Data Provisioning Adapter Tasks**

A user may need to be assigned specific roles and privileges to accomplish tasks when configuring the Data Provisioning Agent and Data Provisioning Adapters.

**Note**
Permissions may also be required for accessing a particular database through a data provisioning adapter. See the SAP HANA Smart Data Integration documentation for complete information.

**Note**
The information given below is for SAP HANA studio and SAP HANA Web-based Development Workbench only.

<table>
<thead>
<tr>
<th>Task</th>
<th>Roles and Privileges</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register a DP Agent</td>
<td>System privilege:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· AGENT_ADMIN</td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Roles and Privileges</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Register an adapter</td>
<td><strong>System privilege:</strong>&lt;br&gt;· ADAPTER ADMIN</td>
<td></td>
</tr>
<tr>
<td>Configure DP Agent to use HTTP (cloud) protocol</td>
<td><strong>Role:</strong>&lt;br&gt;· sap.hana.im.dp.proxy::AgentMessaging</td>
<td>Whoever sets the DP Agent to use HTTP (cloud) in the DP Agent Configuration tool needs to be assigned this role.</td>
</tr>
<tr>
<td>Create an Agent or adapter when SAP HANA is in the cloud</td>
<td><strong>Application privilege:</strong>&lt;br&gt;· sap.hana.im.dp.admin::Administrator</td>
<td>Needed when administrator want to create adapters/agent from agent config tool when SAP HANA is on the cloud (or Agent uses HTTP protocol).</td>
</tr>
</tbody>
</table>

### Monitoring Tasks

A user may need to be assigned specific roles or privileges to access and perform various tasks through the Data Provisioning monitors, which can be accessed from the SAP HANA cockpit.

<table>
<thead>
<tr>
<th>Task</th>
<th>Roles and Privileges</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring</td>
<td><strong>Role:</strong>&lt;br&gt;· sap.hana.im.dp.monitor.roles::Monitoring&lt;br&gt;<strong>Application privilege:</strong>&lt;br&gt;· sap.hana.im.dp.monitor::Monitoring</td>
<td>The Monitoring role includes the following application privileges&lt;br&gt;· sap.hana.ide::LandingPage&lt;br&gt;· sap.hana.im.dp.monitor::Monitoring</td>
</tr>
<tr>
<td>Task</td>
<td>Roles and Privileges</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Role:</td>
<td>sap.hana.im.dp.monitor.roles::Operations</td>
<td>The Operations role includes the following application privileges (sap.hana.im.dp.monitor):</td>
</tr>
<tr>
<td></td>
<td>• AddLocationToAdapter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• AlterAgent</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• AlterRemoteSource</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• AlterRemoteSubscription</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CreateAgent</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• DeleteSchedule</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• DropAgent</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ExecuteDesignTimeObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• NotificationAdministration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ProcessRemoteException (This includes both remote source and remote subscription exceptions)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• RemoveLocationFromAdapter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ScheduleDesignTimeObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ScheduleTask</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• StartTask</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• StopTask</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• UpdateAdapter</td>
<td></td>
</tr>
</tbody>
</table>

**Remote Source and Remote Subscription Tasks**

A user may need to be assigned specific roles or privileges to create and manage remote sources.

<table>
<thead>
<tr>
<th>Task</th>
<th>Roles and Privileges</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a remote source</td>
<td>System privilege: • CREATE REMOTE SOURCE</td>
<td>If a user can create a remote source (has CREATE REMOTE SOURCE system privilege), that user automatically has CREATE VIRTUAL TABLE, DROP, CREATE REMOTE SUBSCRIPTIONS and PROCESS REMOTE SUBSCRIPTION EXCEPTION privileges; they don’t need to be assigned to the user. However, this only applies to remote sources that the user creates themselves. If a remote source is created by someone else, then those privileges must be assigned, for each remote source, in order to perform those tasks.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task</th>
<th>Roles and Privileges</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a remote source in SAP HANA Web-based Development Workbench</td>
<td>Role: • sap.hana.xs.ide.roles::CatalogDeveloper</td>
<td></td>
</tr>
</tbody>
</table>
### Task

<table>
<thead>
<tr>
<th>Task</th>
<th>Roles and Privileges</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alter a remote source</td>
<td><strong>Object privilege:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- ALTER</td>
<td>In order to alter a remote source, the user must have the ALTER object privilege on the remote source. Examples of altering a remote source include:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- ALTER REMOTE SOURCE &lt;remote_source_name&gt; SUSPEND CAPTURE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- ALTER REMOTE SOURCE &lt;remote_source_name&gt; RESUME CAPTURE</td>
</tr>
<tr>
<td>Drop a remote source</td>
<td><strong>Object privilege:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- DROP</td>
<td>Must be explicitly granted for a remote source created by another user.</td>
</tr>
<tr>
<td>Search for an object in a remote source</td>
<td><strong>Object privilege:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- ALTER on the remote source to be searched.</td>
<td></td>
</tr>
<tr>
<td>Add a virtual table</td>
<td><strong>Object privilege:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- CREATE VIRTUAL TABLE</td>
<td>Must be explicitly granted for a remote source created by another user.</td>
</tr>
</tbody>
</table>

### Replication Task and Flowgraph Tasks

A user may need to be assigned specific roles and privileges to create and run flowgraphs and replication tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Roles and Privileges</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a flowgraph</td>
<td><strong>Role:</strong></td>
<td>Allows creation of .hdbflowgraph.</td>
</tr>
<tr>
<td></td>
<td>- sap.hana.xs.ide.roles::EditorDeveloper</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Object privilege:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- EXECUTE on &quot;SYS_REPO&quot;.&quot;TEXT_ACCESSOR&quot; and &quot;SYS_REPO&quot;.&quot;MULTI_TEXT_ACCESSOR&quot;</td>
<td></td>
</tr>
<tr>
<td>Create a flowgraph of type Task</td>
<td><strong>Object privilege:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- SELECT (for input/output schema)</td>
<td></td>
</tr>
<tr>
<td>Create a replication task</td>
<td><strong>Role:</strong></td>
<td>Allows creation of .hdbreptask.</td>
</tr>
<tr>
<td></td>
<td>- sap.hana.xs.ide.roles::EditorDeveloper</td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Roles and Privileges</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Activate replication task (.hdbreptask)</td>
<td><strong>Object privileges:</strong>&lt;br&gt;- SELECT on the source schema&lt;br&gt;- CREATE VIRTUAL TABLE on REMOTE SOURCE (Initial Load Only)&lt;br&gt;- CREATE REMOTE SUBSCRIPTION on REMOTE SOURCE (for real time scenarios)</td>
<td>Must be granted to _SYS_REPO.</td>
</tr>
<tr>
<td>Activate flowgraph (.hdbflowgraph)</td>
<td><strong>Object privileges:</strong>&lt;br&gt;- SELECT on the source table&lt;br&gt;- INSERT, UPDATE, and DELETE on the target table&lt;br&gt;- SELECT on the target schema (only when using a Template Table as a target)&lt;br&gt;- If sequence is used, then GRANT SELECT on sequence&lt;br&gt;- History Table:&lt;br&gt; - GRANT INSERT on History Table&lt;br&gt;- GRANT SELECT on Target Table.</td>
<td>Must be granted to _SYS_REPO.</td>
</tr>
<tr>
<td>Execute a stored procedure</td>
<td><strong>Object privilege:</strong>&lt;br&gt;- EXECUTE</td>
<td>Needed on the schema where the stored procedure is located.</td>
</tr>
<tr>
<td>Execute a task</td>
<td><strong>Object privilege:</strong>&lt;br&gt;- EXECUTE&lt;br&gt;- INSERT&lt;br&gt;- UPDATE&lt;br&gt;- SELECT&lt;br&gt;- DELETE</td>
<td>Needed on the schema where the task is located.</td>
</tr>
<tr>
<td>Use the JIT (just-in-time) Data Preview option</td>
<td><strong>Object privilege:</strong>&lt;br&gt;- SELECT and EXECUTE with GRANT OPTION</td>
<td>Must be granted to _SYS_REPO user. Needed on the schema where the task or stored procedure is located.</td>
</tr>
</tbody>
</table>

8. **Connect to SAP HANA.**

   Specify connection information and administrator credentials when the SAP HANA system is located on premise and does not require a secure SSL connection.
   a. Navigate to the `<DPAgent_root>/configTool` directory.
   b. Start the configuration tool.
      ○ On Windows, run `dpagentconfigtool.exe`. 
- On Linux, run `.dagentconfigtool`.

**Note**
Start the configuration tool using the Data Provisioning Agent installation owner. The installation owner is the same user that is used to start the agent service.

- Connect to the SAP HANA server.
  - Click **Connect to SAP HANA**.
  - Specify the hostname, port, and SAP HANA administrator credentials for the SAP HANA server.

**Note**
The administrator user that you use to connect to the SAP HANA system must have been granted the **AGENT ADMIN** and **ADAPTER ADMIN** system privileges. If the user that you want to use does not already have these privileges, you must grant them before you can connect to the SAP HANA system.

**Tip**
To determine the correct port number when SAP HANA is deployed in a multi-database configuration, execute the following SQL statement:

```
SELECT DATABASE_NAME, SERVICE_NAME, PORT, SQL_PORT, (PORT + 2) HTTP_PORT FROM SYS_DATABASES.M_SERVICES WHERE DATABASE_NAME='<DBNAME>' and ((SERVICE_NAME='indexserver' and COORDINATOR_TYPE='MASTER') or (SERVICE_NAME='xsengine'))
```

9. Register the agent.

Before you can use adapters deployed on the Data Provisioning Agent, you must register the agent with SAP HANA.

**Prerequisites:**
- The Agent Admin HANA User must have the following roles or privileges.

<table>
<thead>
<tr>
<th>Action</th>
<th>Role or Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register adapter</td>
<td>- System privilege: AGENT ADMIN</td>
</tr>
</tbody>
</table>

- For SAP HANA on Cloud, the Agent XS HANA User must have the following roles or privileges.

<table>
<thead>
<tr>
<th>Action</th>
<th>Role or Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register adapter</td>
<td>- System privilege: AGENT ADMIN</td>
</tr>
<tr>
<td>Messaging between the agent and SAP HANA on Cloud</td>
<td>- Application privilege: sap.hana.im.dp.proxy::AgentMessaging</td>
</tr>
</tbody>
</table>

- Start the agent configuration tool and connect to the SAP HANA server.
  - The agent configuration tool is located at `<DPAgent_root>/configTool`.
- Click **Register Agent**.
- Specify the agent connection information.
If SAP HANA is not in the cloud, specify the agent name and hostname:
  - Ensure that the SAP HANA server can communicate with the agent host. Depending on the network configuration, you may need to fully qualify the agent hostname.
  - Ensure that your firewall settings allow the connection from the SAP HANA server to the agent host on the listener port. By default, port 5050.
- If SAP HANA is in the cloud, specify the agent name.
  - When SAP HANA is in the cloud, the agent service will be restarted to complete the registration process.

**d. Click Register.**

The agent is registered with SAP HANA. If SAP HANA is in the cloud, the agent service is automatically restarted.

To **unregister** the agent, click **Unregister Agent**.

**Caution**

*Unregistering* the agent from the SAP HANA server performs a cascade drop of the agent. As a result, any remote subscriptions that use the agent will also be deleted, even if they are active.

10. **Register adapters.**

Before you can connect to remote sources using an adapter, you must register the adapter with SAP HANA.

**Prerequisites:**

The HANA administrator user must have the following roles or privileges.

<table>
<thead>
<tr>
<th>Action</th>
<th>Role or Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register an adapter</td>
<td>- System privilege: ADAPTER ADMIN</td>
</tr>
<tr>
<td></td>
<td>- Application privilege: sap.hana.im.dp.admin::Administrator</td>
</tr>
</tbody>
</table>

**Note**

This application privilege is required only for SAP HANA in the cloud.

**Note**

Before you register the adapter with the SAP HANA system, be sure that you have downloaded and installed the correct JDBC libraries (if necessary). For information about the proper JDBC library for your source, see the *Product Availability Matrix (PAM)*.

Place your JDBC library in `<DPAgent_root>/lib`, and you may need to manually create the `/lib` folder.

- **Start the Data Provisioning Agent Configuration tool and connect to SAP HANA.**
- **For custom adapters, click** Deploy Adapter **and point to the adapter JAR files.**
c. Select the adapter to register and click **Register Adapter**.

d. If required, configure the source system to which the adapter connects.

   For example, log reader adapters require source configuration to enable real time replication.

The selected adapter is registered with SAP HANA and can be selected when creating a remote source.

11. **Next steps.**

   After installation is complete, you will need to complete some other tasks to access and move data.

   When you have completed the installation and connected to HANA, you will want to begin creating remote sources, and replicating or transforming your data.

   For complete information about SAP HANA smart data integration, see the SAP Help Portal.

**Related Information**

- Reconfigure the Java Runtime Environment
- SAP HANA Smart Data Integration and SAP HANA Smart Data Quality Documentation
5  Configuring Data Collection

Enable or disable telemetry data collection, and delete collected data.

When you install SAP HANA 2.0, express edition, data collection is enabled by default. You can disable data collection after installing SAP HANA, express edition. Data collection sends anonymous performance statistics and usage statistics to SAP, so that SAP can focus development efforts on areas most vital to the SAP HANA, express edition customer base.

**Note**

Your privacy is important to SAP. Telemetry collects anonymous usage information while ensuring complete privacy. No identifying information or private information is collected, and you can opt out of telemetry at any time.

To disable data collection, log on to your Cockpit and go to the **Notifications and Feedback** section. Click on **Configure telemetry data collection**. Uncheck the **Enable Telemetry Data Collection** box and click **Save**.

You can also delete data that has been collected by clicking the **Delete Collected Data** button and selecting **Confirm**.

If you are inside a corporate firewall and use a proxy for connecting to HTTP and HTTPS servers, you need to identify your proxy settings, log in to Cockpit, and update the **Cockpit Settings Proxy** page.

**Note**

If you modify the proxy settings through Cockpit, you must manually restart the Cockpit services for the changes to apply.

```
xs restart cockpit-hdb-svc
xs restart cockpit-xsa-svc
```
5.1 Disable and Enable Data Collection via Command Line

Disable data collection through the command line if you wish to stop sending anonymous performance data to SAP and you do not have access to Cockpit.

Procedure

1. Start SAP HANA 2.0, express edition and log in as the hxeadm user.
2. To disable data collection, run:
   ```
   /usr/sap/hxe/home/bin/hxe_telemetry.sh -i 90 -u SYSTEM -p "<password>" -d SystemDB --disable
   ```
3. To re-enable telemetry, run:
   ```
   /usr/sap/hxe/home/bin/hxe_telemetry.sh -i 90 -u SYSTEM -p "<password>" -d SystemDB --enable
   ```

   To learn more about the `hxe_telemetry.sh` script, type `./hxe_telemetry.sh --help`.

5.2 Check your Proxy Settings

If you are inside a corporate firewall and use a proxy for connecting to http and https servers, check your proxy settings using SAP HANA Cockpit.

Procedure

1. Obtain your proxy settings from your system administrator. You set your proxy settings earlier in this tutorial.

   i  Note
   If you are not inside a firewall, you can ignore this step and skip to the next topic.

   ◦ In this example using Internet Explorer on Windows 10, notice how connections use a proxy server on port 8080.
2. In the Cockpit Manager of the SAP HANA Cockpit, select **Cockpit Settings ➤ Proxy**.
3. Under **Http(s) Proxy**, verify that **Enable** is checked.

   **Note**

   **Http(s) Proxy** should be enabled, not the **Network Proxy**.

4. In **Host**, **Port**, and **Non Proxy Hosts**, verify the settings provided by your IT administrator.

   Make sure **Host** has a fully qualified domain name.

   Make sure the **Non Proxy Hosts** list includes **localhost**, **hxehost**, and **hxehost.localdomain**.

5. If you made any changes, click **Save**.
6 Advanced Configuration

Optional advanced configuration procedures.

6.1 Adjust the Global Allocation Limit

Set how much memory SAP HANA, express edition utilizes by modifying the `global_allocation_limit` parameter in the `global.ini` file.

**Context**

The unit for `global_allocation_limit` is MB. The default value is 0, which sets the maximum memory to the minimum of your machine limit and license limit. If the machine size is less than 16 GB, the maximum memory is set to 16 GB.

**Procedure**

1. Connect to HANA Studio.
   
   Connect to the HANA studio with systemdb credentials.

2. Click the Configuration tab.
   
   In the administration editor of HANA Studio, choose the Configuration tab. A list of all configuration files appears.

3. Expand `global.ini`.
   
   Expand the `global.ini` configuration file.

   
   In the `global.ini` configuration file change the value of the `global_allocation_limit` in the `memorymanager` section.

   Do not set `global_allocation_limit` to a value above the limit of your license. This can cause database lockdown.

**Note**

If you’re using SAP HANA, express edition for configuring multiple replayers, please be aware that you will need to modify the global allocation limit of each SAP HANA, express edition installation to provide...
sufficient memory for the replayer process. In order to estimate the required memory, please use the formula cited in the SAP HANA Capture and Replay Guide - Best Practices for Setting Up, Capturing, Replaying, and Analyzing.

You can modify the global allocation limit in the ini file of each installation. Please note that the use of replayers does not require the SAP HANA, express edition installation to be up and running, but is still affected by the global allocation limit defined for the installed system. Please note that when changing the global allocation limit of SAP HANA, express edition installations, the database itself can exceed the maximum memory allowed free of charge. This can result in a lockdown of the database itself by the license manager, which will not impact the replayer process, but will render the database unusable until the next restart.

For more information on the scenario setup, please refer to this blog.

6.1.1 Virtual Machine: Checking Resource Usage

**Issue:** You are having memory issues on your VM and want to check resource usage.

**Solution:** If you have HANA studio, right-click on the system and select Configuration and Monitoring > Open Administration and check the Overview and Landscape tabs for anything in red.

If you don’t have HANA studio, run the following queries in hdbsql to view SAP HANA resource usage:

```sql
select service_name, round(effective_allocation_limit/1024/1024/1024, 1) as MemLimit,
       round(total_memory_used_size/1024/1024/1024,1) as MemUsed from m_service_memory;
```

If the MemUsed is close to the MemLimit, you may encounter problems allocating memory.

Alternatively, you can run the Linux `free` command at the command line to see free resources:

```bash
free -g
```

The key number is in the second row (-/+ buffers/cache) in the `free` column. If this number is low (e.g. 0 GB), you may have run out of memory when performing your recent operation.

You can also run the following command to see if you are running out of disk space on the VM’s file system:

```bash
df -h
```

Look for the `Use%` for the `/dev/sda1` file system. If it is down to just a few GB, you may have run out of disk space when performing your recent operation.
7 Best Practices

7.1 Backups

Make regular data backups to save your work.

For information on data backup, recovery, and log file growth, see the SAP HANA Administration Guide.

7.2 Deactivate the SYSTEM user

SYSTEM is the database superuser and is not intended for day-to-day activities in production systems. For better security, you can create other database users with only the privileges that they require for their tasks (for example, user administration), then deactivate the SYSTEM user.

Procedure

1. In a terminal, log in as the hxeadm user:
   
   ```
   sudo su -l hxeadm
   ```

2. Create a new admin user with the USER ADMIN system privilege:
   
   ```
   /usr/sap/HXE/HDB90/exe/hdbsql -i 90 -d SystemDB -u SYSTEM -p "<SYSTEM-password>" "CREATE USER <admin-username> PASSWORD <admin-password> NO FORCE_FIRST_PASSWORD_CHANGE;"
   /usr/sap/HXE/HDB90/exe/hdbsql -i 90 -d SystemDB -u SYSTEM -p "<SYSTEM-password>" "GRANT USER ADMIN TO <admin-username> WITH ADMIN OPTION;"
   ```

3. Use the new admin user to deactivate the SYSTEM user:
   
   ```
   /usr/sap/HXE/HDB90/exe/hdbsql -i 90 -d SystemDB -u <admin-username> -p "<admin-password>" "ALTER USER SYSTEM DEACTIVATE USER NOW;"
   ```
8 Updating SAP HANA, express edition

Update SAP HANA 2.0, express edition when new patches are released.

Prerequisites

If you are updating to SAP HANA, express edition 2.0 SP 02, the libgcc_s1 and libstdc++6 packages must be version 6.2 or newer. To update these packages, register your system with SUSE and run `zypper install libgcc_s1 libstdc++6`. For registration instructions, see the SUSE Linux Enterprise Server 12 documentation.

Context

Note

Upgrading is supported only for SAP HANA, express edition 2.0 (SP 00 onward). Upgrading from SAP HANA, express edition 1.0 SP 12 is not supported.

Note

If you haven't started the tenant database, or reset the tenant database system password since installation, you need to do so before the upgrade.
- Login to SystemDB database and run:

  ```sql
  ALTER SYSTEM START DATABASE HXE
  ```

Login to HXE tenant database with system user and change the password.

Procedure

1. Log in as hxeadm.
2. Depending on your version of SAP HANA, express edition, you will either use the built-in update utility, or download the new versions of SAP HANA, express edition through the Download Manager. Your primary choice should be the built-in update utility.
   - Check the VM's built-in update utility found in the ~/home/bin directory. Depending on your VM, use either HXECheckUpdate_linux.bin for Linux x86-64, and HXECheckUpdate.jar for Linux PPC64. Follow the prompts to download the new files. By default, they will be downloaded to
The downloaded files will be hxe.tgz, hxexsa.tgz, and all the optional components you have installed.

HXECheckUpdate_linux.bin -a

- If you do not have the update utility, use the Download Manager, select Binary Installer and download the latest files for hxe.tgz, hxexsa.tgz, and all the optional components you want to install.

For Download Manager (console mode) command line syntax, see (Optional) Download Using the Download Manager (Console Mode) [page 14].

3. Extract all of the downloaded packages to the same directory.

```bash
    tar -zxf hxe.tgz
    tar -zxf hxexsa.tgz
```

4. Navigate to the directory where you extracted the packages:

```bash
    cd <extract_path>/HANA_EXPRESS_20
```

**Note**

If the update you are applying includes the Applications package, increase your allocated memory by 3.5 GB and run ./hxe_gc.sh. Follow the prompts and then continue with the procedure.

5. As the root user, run the upgrade script to update the server:

```bash
    sudo ./hxe_upgrade.sh
```

6. Follow the prompts to complete the server update.

**Note**

hxe_upgrade.sh detects the server and applications packages. The script will upgrade the server the optional components.
9 Uninstalling SAP HANA, express edition

To uninstall SAP HANA, express edition, simply remove the virtual machine from your hypervisor.

9.1 Uninstalling the SAP EA Designer Component

Procedure

1. As the hxeadm user, log in to XSA:
   
   ```
   xs login -u xsa_admin -p "<password>" -s SAP
   ```

2. Uninstall the SAP EA Designer software component. To uninstall the component plus the HDI container and repository database, use the following command:
   
   ```
   xs uninstall XSAC_HANA_EA_D --delete-services
   ```

   To delete the component but retain the HDI container and repository database, use the following command:

   ```
   xs uninstall XSAC_HANA_EA_D
   ```
10 Troubleshooting

10.1 SAP HANA XS Applications Run Error

**Issue:** You are trying to run an SAP HANA service on your SAP HANA 2.0, express edition installation and are receiving an error.

**Solution:** Log in to your SAP HANA 2.0, express edition as `<sid>adm`:

```
sudo su -l <sid>adm
```

Check which services are enabled on your machine:

```
xs apps
```

This operation may take 1-2 minutes to return the list of apps. You should see the following:

```
<table>
<thead>
<tr>
<th>Name</th>
<th>Status</th>
<th>Instance</th>
<th>Memory</th>
<th>Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>xpc</td>
<td>STARTED</td>
<td>1/1</td>
<td>128 MB</td>
<td>51829</td>
</tr>
<tr>
<td>db</td>
<td>STARTED</td>
<td>1/1</td>
<td>256 MB</td>
<td>51825</td>
</tr>
<tr>
<td>di-cert-admin-ui</td>
<td>STARTED</td>
<td>1/1</td>
<td>16.0 MB</td>
<td>51826</td>
</tr>
<tr>
<td>di-space-provisioning-ui</td>
<td>STARTED</td>
<td>1/1</td>
<td>16.0 MB</td>
<td>51827</td>
</tr>
<tr>
<td>xccche</td>
<td>STARTED</td>
<td>0/1</td>
<td>512 MB</td>
<td>51820</td>
</tr>
<tr>
<td>jobscheduler-db</td>
<td>STOPPED</td>
<td>0/1</td>
<td>256 MB</td>
<td>51839</td>
</tr>
<tr>
<td>jobscheduler-rest</td>
<td>STOPPED</td>
<td>0/1</td>
<td>1.00 GB</td>
<td>51839</td>
</tr>
</tbody>
</table>
```

If the service you’re trying to use is shown as STOPPED, start it:

```
xs start <app>
```

It may take a few minutes for the system to get started. Run `xs apps` again to see if the app has started and that under instances the app shows 1/1.

10.2 Download Manager Shows Error "Failed to concatenate downloaded files"

**Issue:** You are downloading packages using the Download Manager. The Status area and Progress Detail area show the error `Failed to concatenate downloaded files`.

**Solution:**

1. Check the log file for details. The log file is in the temp directory:
2. If the log indicates a simple issue such as lack of disk space or file permissions, fix the problem and download again.
3. If the problem is less obvious, do the following:
   ○ Go to the Save directory. Delete incomplete download files. Download again.
   or
   ○ Change the Save directory. Download again.

10.3 Unable to Obtain an IPv4 Address in VMWare

**Issue:** You are unable to obtain an IPv4 hxehost IP address. You are using a VMWare hypervisor.

VMWare defaults to bridged networking. You may need to adjust VMWare’s network adapter settings in certain circumstances.

If you are behind a proxy or a firewall, your institution’s network may prevent VMWare from assigning an IPv4 address when you attempt to locate your hxehost IP address.

**Solution:**
1. In VMWare, change your network adapter settings from Bridged to NAT.
2. Wait a few minutes.
3. At the command prompt, enter `sudo ifconfig` to see if an IPv4 address is now assigned. You do not need to restart your VM.

10.4 Error Indicates Package is not Compatible with Installed SAP HANA, Express Edition Version

**Issue:** You downloaded an optional component package using the Download Manager, but an error occurs when you try to install it.

**Context**

The error message reads something similar to:

Cannot install EA Designer. This EA Designer version is not compatible with your installed HANA, express edition version.

If you see this message, the optional component is newer than your server, and is not compatible.
Procedure

1. Login as <sid>adm (hxeadm for prepackaged VM users).
2. Run ~/bin/HXEDownloadManager_linux.bin to download the compatible version. See Updating SAP HANA, express edition [page 82].

   **Note**

   Note that as of SAP HANA 2.0, express edition Revision 022, the Download Manager will download packages only if they are at the same version as your server. This is convenient in situations where you haven’t upgraded for a while. It eliminates the risk of downloading a package that is too recent for your server.

3. Read the release notes for additional information.

10.5 Upgrade Script Hangs While Upgrading VM Installation

**Issue:** When you run hxe_upgrade.sh, you notice the upgrade hangs.

**Context**

**Solution:** The VM is low on memory. Run the hxe_gc memory management script.

**Procedure**

1. Open a new terminal to your VM.
2. Run the memory management script.
   
   The hxe_gc memory management script frees up available VM memory.
   
   - In your VM, log in as hxeadm and enter:
     
     ```
     cd /usr/sap/HXE/home/bin
     ```
   - Execute:
     
     ```
     hxe_gc.sh
     ```
   - When prompted for System database user (SYSTEM) password, enter the New HANA database master password you specified during SAP HANA, express edition installation.

   The cleanup process runs. The command prompt returns when the cleanup process is finished.
10.6 Error When Accessing the Database Explorer from Cockpit

**Issue:** You get an error when opening the database explorer from cockpit.

**Solution:** Open the database explorer manually:

1. As the hxeadm user, log in to XSA services:
   
   ```
   xs-admin-login
   ```
   
   At the prompt for the XSA_ADMIN password, enter the master password.

2. Get the URL for the hrtt-core application:
   
   ```
   xs apps | grep hrtt-core
   ```

   ![Screen capture showing hrtt-core application details]

3. Enter the URL for hrtt-core in a browser.

4. Log in as XSA_ADMIN.
5. Add the database using **SAP HANA Database (Multitenant)** as the database type.

![Add Database form](image)

10.7 Error When Stopping the System from Cockpit

**Issue:** You get an error when stopping the SAP HANA, express edition system from cockpit.

**Solution:** Stop the system manually.

In your VM, as the hxeadm user, enter:

```
HDB stop
```
Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.

About the icons:

- Links with the icon : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your agreements with SAP) to this:
  - The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
  - SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any damages caused by the use of such content unless damages have been caused by SAP’s gross negligence or willful misconduct.
- Links with the icon : You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of example code unless damages have been caused by SAP’s gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.